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1: Welcome

Welcome to the I04AB User's Guide. Inside you'll find instructions on how to set up EtherNet/IP™ messaging
between an Allen-Bradley Logix™ controller and Opto 22's SNAP PAC I/0 using Opto 22's EtherNet/IP
Configurator as well as Allen-Bradley’s RSLogix™* 5000 software. (For a list of supported Allen-Bradley platforms,
see page 95.)

This guide assumes that you are already familiar with how to use Allen-Bradley’s RSLogix 5000 software to
configure Allen-Bradley devices.

S
.

SNAP PAC EB-series
:\.\v

=z

| e

SNAP PAC R-series

———

DT S

SNAP PAC S-series

PLCs

EtherNet/IP automation environment with PLCs and Opto 22 devices

USING THIS GUIDE

Chapter 1: Welcome——Provides information about this guide, where to find additional information, and how
to reach Opto 22 Product Support.

Chapter 2: Introduction to I04AB—An overview of Opto 22's implementation of EtherNet/IP, and the things
you will need to get started.
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DOCUMENTS AND ONLINE HELP

Chapter 3: Getting Started—How to install Ethernet/IP Configurator, add an Opto_22 device to the network,
and configure I/O modules and points.

Chapter 4: Setting Up Implicit Messaging—How to use EtherNet/IP Configurator and RSLogix 5000 software
to set up implicit messaging between an Allen-Bradley controller and Opto 22 remote I/0.

Chapter 5: Setting Up Explicit Messaging—How to use the EtherNet/IP Configurator and RSLogix 5000 to
implement explicit messaging.

Chapter 6: Connecting PAC Control and Allen-Bradley Systems—How to connect a SNAP-PAC-S controller
with an Allen-Bradley ControlLogix programmable logic controller (PLC) in order to exchange data.

Chapter 7: Using EtherNet/IP Configurator—Additional information about EtherNet/IP Configurator not
included previous chapters.

Appendix A: Supported Allen-Bradley Platforms—Lists the Allen-Bradley controllers that support EtherNet/IP.

Appendix B: Using Counts—Describes using counts with EtherNet/IP and linearizing the Pt100 and Pt1000
probes from resistance.

Appendix C: Worksheets and Calculations—Provides a variety of worksheets to help you determine your
system'’s requirements.

Appendix D: Connecting with MicroLogix—Provides information for connecting to a MicroLogix 1100 or 1400
PLC.

Appendix E: Detecting /0 Communication Failures—Describes how ladder logic detects an 1/0
communication failure.

Appendix F: Generic Ethernet Module Options—Provides information on selecting a communications format.

Appendix G: Accessing Serial Data—Describes how to use a SNAP PAC controller to handle the
communication with a SNAP PAC serial module and make the data accessible to an Allen-Bradley controller.

DOCUMENTS AND ONLINE HELP

You may also need the following Opto 22 hardware documentation, depending on your application:

For this information See this guide Form
Installing and using SNAP PAC brains SNAP PAC Brain User’s Guide 1690
Il(r;rsstalllng and using SNAP PAC R-serles control- g4 5 pac R Serles Controller User's Guide 1595
Installing and using SNAP PAC S-series control- o\ b paG S-series Controller User's Guide 1592

lers

Using the OptoMMP Communication Toolkit or the
IEEE 1394-based OptoMMP memory-mapped pro- OptoMMP Protocol Guide 1465
tocol for programming

Wiring, specifications, and installation information

for SNAP Analog Input Modules SNAP Analog Input Modules Data Sheet 1065

Wiring, specifications, and installation information

for SNAP Analog Output Modules SNAP Analog Output Modules Data Sheet 1066

Wiring, specifications, and installation information

for SNAP High-Density Digital Modules SNAP High-Density Digital Modules Data Sheet 1556

Wiring, specifications, and installation information

for SNAP Digital Input Modules SNAP Digital Input Modules Data Sheet 0773

Wiring, specifications, and installation information

for SNAP Digital Output Modules SNAP Digital Output Modules Data Sheet 1144
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https://www.opto22.com/support/resources-tools/documents/1690-snap-pac-brains-users-guide
https://www.opto22.com/support/resources-tools/documents/1595-snap-pac-r-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1592-snap-pac-s-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1065-snap-analog-input-modules-data-sheet
https://www.opto22.com/support/resources-tools/documents/1066-snap-analog-output-modules-data-sheet
https://www.opto22.com/support/resources-tools/documents/1556-snap-high-density-digital-modules-data-sheet
https://www.opto22.com/support/resources-tools/documents/0773-snap-digital-input-modules-data-sheet
https://www.opto22.com/support/resources-tools/documents/1144-snap-digital-output-modules-data-sheet

CHAPTER 1: WELCOME

For this information See this guide

Wiring, specifications, and installation information

. ; SNAP Isolated Analog Input Modules Data Sheet 1182
for isolated analog input modules

Wiring, specifications, and installation information

; SNAP Serial Communication Modules Data Sheet 1184
for serial modules

Using EtherNet/IP commands with remote Opto 22
SNAP PAC I/0 with an Allen-Bradley® Logix™ Ethernet/IP for SNAP PAC Protocol Guide 1770
controller

Latest release, installation, and system require-

ments information for EtherNet/IP Configurator. EtherNet/IP Configurator Readme Notes

All documents are available on our website, Opto22.com. Follow the link above or search on the document’s
form number.

Additional resources are also available on the Opto 22 Web site, including videos on how to use Opto 22 1/0
with Allen-Bradley systems.

Additional Resources for EtherNet/IP

For an overview of CIP and EtherNet/IP technology, see
http://www.odva.org/Portals/0/Library/Publications_Numbered/PUB00138R2_CIP_Adv_Tech_Series_FtherN
etlPpdf

For information on the network infrastructure for EtherNet/IP, see
http://www.odva.org/Portals/0/Library/Publications_Numbered/PUB00035R0_Infrastructure_Guide.pdf

For a good starting point for Ethernet/IP research on the ODVA web site, see
http://www.odva.org/default.aspx?tabid=67

PRODUCT SUPPORT

If you have any questions about using EtherNet/IP to communicate with Opto 22 devices, you can call, fax, or
email Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free NOTE: Email messages and phone calls
in the US. and Canada) to Opto 22 Product Support are
951-695-3080 grouped together and answered in the
Monday through Friday, order received.
7a.m.to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: WwWw.0pto22.com

When calling for technical support, be prepared to provide the following information about your system to
the Product Support engineer:

«  Version of this product

«  PCconfiguration (type of processor, speed, memory, operating system)
«  RSLogix 5000 version

«  PLCmodel

»  PLCfirmware version

«  Complete description of your hardware system, including:

I04AB User's Guide 3
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2: Introduction to I04AB

This chapter includes a brief introduction to Ethernet/IP and how it is implemented in Opto 22 products. It
also provides guidance in selecting a messaging type.

Built on the standard TCP/IP suite of protocols, EtherNet/IP gets the “IP” part of its name from CIP™, the
Common Industrial Protocol”. As the name implies, EtherNet/IP adapts CIP to standard Ethernet technology,
and thus provides tools to deploy manufacturing applications on an enterprise network. Introduced in 2001,
EtherNet/IP is now supported by hundreds of vendors around the world and is a standard networking
solution in industrial automation.

IN THIS CHAPTER

Opto 22 Advantage
Opto 22 Products
Architecture
Implicit and Explicit Messaging
Using CIP Objects
Specifications

O 00 N~ Oy 1

OPTO 22 ADVANTAGE

Using EtherNet/IP, Allen-Bradley Logix controllers can communicate with remote Opto 22 I/0 and take
advantage of Opto 22's distributed intelligence. With distributed intelligence, a controller (such as an
Allen-Bradley controller), handles overall control but does not have to attend to every detail of every process.
The 1/0's own onboard processor (also called a brain or device) has the intelligence to handle not only on/off
control but also functions such as latching, counting, thermocouple linearization, even PID loops. With these
functions running locally on the I/0 unit, they still do their job even if communication to the controller is lost,
and the load on the controller is reduced.
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OPTO 22 PRODUCTS

Automation made simple.

By connecting to Opto 22 devices as remote 1/O, you can add the rich and sophisticated functionality of
Opto 22 equipment to your EtherNet/IP systems. While other manufacturer’s devices may report only states
and counts, our SNAP PAC System devices can provide access to the following functions:

«  Power consumption «  Thermocouple linearization

»  Power line monitoring «  Temperature conversion

«  PIDloop control (up to 96 loops) «  Quadrature counting

o Serial device control (RS-232/485) « Input latching

»  Analog scaling »  Pulse generation and measurement
«  Offsetand gain «  High-speed counting (up to 20 kHz)
«  Analog ramping «  Frequency and period measurement
+  Output clamping »  Digital and analog totalizing

»  Filter weight «  Watchdog timeout

«  Minimum and maximum values «  Time-proportional output

»  Engineering unit conversion +  Load cell

OPTO 22 PRODUCTS

You can use a variety of Ethernet-capable devices from the SNAP PAC family of products in an EtherNet/IP
environment, including SNAP PAC controllers and brains. There are two basic approaches:

»  Use SNAP PACI/O with a SNAP PAC EB-series brain or R-series controller as intelligent remote I/0 with an
EtherNet/IP-enabled scanner such as an Allen-Bradley PLC.

NOTE: SNAP PAC EB-series brains are equipped with LEDs that report the EtherNet/IP module status (MS) and
network status (NS). For more information, see form 1690, the SNAP PAC Brains User’s Guide.

o Use SNAP PAC S-series or R-series controllers to exchange scratch pad variable data with an
EtherNet/IP-enabled scanner such as an Allen-Bradley PLC.

6 I04AB User's Guide



CHAPTER 2: INTRODUCTION TO I04AB

ARCHITECTURE

In EtherNet/IP terminology, a device may function as either an adapter or a scanner. Our Opto 22 devices are
implemented as adapters, and as such are able to send and receive data only when requested to do so by a
scanner. The Opto 22 device (or adapter) is therefore a target of instructions and requests for information sent
by a scanner, which is usually a PLC, but could be a PC running control software.

An adapter class device receives message requests from all other classes of products, and it can exchange peer
data using messages with any class of device. However, an adapter cannot store or originate the data
communications parameters necessary to establish a connection. Therefore, it cannot originate real-time I/0
data connections, which is why it sends and receives 1/0 data only when it is requested to do so by a scanner.

A scanner is capable of originating I/0 data connection requests with adapter class products, as well as with
other scanner class products. Scanner class devices may also originate or be the targets of explicit connection
requests to and from other classes of products, and they can send or receive messages to or from all other
classes of products.

IMPLICIT AND EXPLICIT MESSAGING

As adapters, SNAP-PAC-EB brains, and SNAP-PAC-R and SNAP-PAC-S controllers are able to exchange
messages with scanners using both explicit and implicit messaging.

Explicit messages are used for request/response transactions between two nodes. The scanner sends a
request and the adapter returns a response. Using TCP/IP, these messages can reach any network-accessible
object attributes and services within a device. Once the modules and points are configured on an Opto 22
device, no additional configuration is required on an Opto 22 device. All programming is done in RSLogix.

Implicit messages transfer data at regular intervals established by the scanner. No request is required, the
request is implied. Implicit messaging connections often are set up as one-to-many relationships and use
UDP/IP to multicast application-specific 1/0 data at regular intervals. When properly configured, the data is
always available to be scanned by the controller. In addition to configuring the modules and points on an
Opto 22 device, you must also create input and output assemblies. An assembly provides the format for the
implicit message packet that includes the information for the point or points you are interested in.

For help with choosing a messaging type, see the next section “Choosing the Messaging Type.”

Choosing the Messaging Type

Implicit messaging is the normal way to communicate with I/O. However, there are times when explicit
messaging is more appropriate. See the reasons below for why you might use one messaging type over the
other. All of these apply for a properly configured Ethernet network (wired or wireless).

Reasons for Using Implicit Messaging

«  Fortypical communications with 1/0 (also called I/O messaging) where an item is scanned or repeated

«  Forasimplerimplementation and less programming in ladder logic. Programming in ladder logic is
required for explicit messaging.

«  Ifyouwant the SNAP I/0 to send data at stated intervals to one or more PLCs without waiting for a
request (input instance), or if you want the PLC to do the same (output instance)

For instructions for using implicit messaging, see “4: Setting Up Implicit Messaging”on page 19.

Reasons for Using Explicit Messaging
«  Ifyou want the PLC to initiate communication at specific points in your ladder logic
«  For communication among controllers (such as exception, handshaking, and access)

I04AB User's Guide 7



USING CIP OBJECTS

«  For more complex commands that are not suited to scanning. For example, Read and Clear Counters.

«  Toroute messages over wide area connections. With explicit messaging, you can access a remote
Opto 22 device over the Internet.

«  Forsending or receiving data on a serial communication module port using the Serial Port object

« Ifthe quantity of data exchanged exceeds ~1000 bytes of input data or ~500 bytes of output data, which
are the limits in RSLogix 5000 software, the excess must be exchanged via explicit messaging

«  Forsome OEM applications, properly configured explicit messaging can require less programming and
program management

For instructions for using explicit messaging, see “5: Setting Up Explicit Messaging”on page 29.

USING CIP OBJECTS

EtherNet/IP accesses device data and functionality as a collection of object attributes and services. As much as
possible, Opto 22 device data and functionality is exposed through standard CIP objects, extended for
additional non-standard functions. In some cases vendor-specific objects are defined for functionality that is
not within the scope of the standard objects.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the CIP classes, all
of which are available through explicit messaging. For information on the CIP classes and attributes, see form
1770, Ethernet/IP for SNAP PAC Protocol Guide.

SPECIFICATIONS

The following specifications apply to any SNAP PAC Ethernet-based brain or controller used as a remote 1/0
unit for an Allen-Bradley PLC:

Description Value

TCP/IP encapsulation connections 16
CIP Connections allowed per TCP/IP connection 2
Implicit Multicast Connections 16
Assembly instances supported 16
Assembly members in all assembly instances 4096

8 |04AB User's Guide


https://www.opto22.com/support/resources-tools/documents/1770-ethernet-ip-for-snap-pac-protocol-guide

3: Getting Started

This chapter describes lists the things you will need in order to implement I04AB. It also describes how to
install EtherNet/IP Configurator and two procedures which you must do for both implicit and explicit
messaging: adding an Opto_22 device to the network and configuring I/0 modules and points.

IN THIS CHAPTER

What You Will Need 9
Installing EtherNet/IP Configuration Software 9
Adding an Opto 22 Device 10
Configuring I/0 Modules and Points 12

WHAT YOU WILL NEED

A SNAP PAC EB-series or R-series device loaded with firmware R8.3a or newer, installed on a mounting
rack with 1/0 modules and connected to the network. See the documentation included with the Opto 22
hardware.

NOTE: If you will be doing the exercises in “5: Setting Up Explicit Messaging” on page 29, and want to run your
example Logix project, you will need a SNAP PAC Learning Center from Opto 22, either part number
SNAP-I04ABLC or SNAP-PACLC. Due to the unavailability of essential parts, we can no longer manufacture these
learning centers. However, if you do not plan to run your example project, you do not need a Learning Center.

EtherNet/IP Configuration Software installed on your computer (see below). EtherNet/IP Configurator is
available as a free download from our website, Opto22.com.

RSLogix 5000, version V13 or newer installed on your computer

ControlLogix PLC 1756-L6x with a 1756-ENBT/A, 1756-EN2T, or 1756-EM2F EtherNet/IP module. You can
also use a CompactlLogix 1769-L32E, a Drivelogix 700s Version 2, or a SoftLogix.

NOTE: Ifyou have a MicroLogix 1100 0r1400 (Series B FRN4 or newer), you can also connect the two systems and
use Explicit Messaging to access data. For more information, see “D: Connecting with MicroLogix”on page 107.

An industrial managed Ethernet switch configured for IGMP.

INSTALLING ETHERNET/IP CONFIGURATION SOFTWARE

The easy-to-use EtherNet/IP Configurator provides the tools you need to configure modules and points, create
input and output assemblies, and download a configuration to an Opto 22 device.

I04AB User's Guide 9
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ADDING AN OPTO 22 DEVICE

ADDING AN OPTO 22 DEVICE

Tabs for configuring I/0
modules and ~—~

assemblies

Toolbar

Configured
devices

Discovered
devices

Status
messages

EtherNet/IP Configurator is available as a free download from our website.

If you are using the download, double-click the downloaded file. The installation wizard should start
automatically. Follow directions to install the software.

If you have a CD that includes the software, insert the CD in your CD-ROM drive. The installation wizard
should start automatically. If it doesn’t, use Windows Explorer to navigate to your CD-ROM drive and then
double-click setup.exe. Follow directions to install the software.

The best way to add an Opto 22 device to the network (and also the configuration) is to allow EtherNet/IP
Configurator to discover the device. (To add a device manually, see “Adding a Device Manually” on page 68.)

Perform the following tasks to open EtherNet/IP Configurator and add an Opto 22 device.
1. To open EtherNet/IP Configurator:

Tools > EtherNet-IP Configurator.

PAC R2 Cookies™ - EtherMNet/IP Configurator

Edit Tools View Help
0= ?

In Windows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 9.6 >

In Windows 10, click the Windows Start button, and then click Opto 22 > EtherNet-IP Configurator.

=I- Add new device...
=1 SHAP_PAC_R
10.182.65.116
SHAP-PAC-R1
I SHAP_PAC_EB
10.1582.65.118
SHAP-PAC-EEL
=I-Discovered Devices
00-A0-30-00-C1-48
00-AD0-30-01-51-D8
00-AD-3D-01-51-DF
00-A0-30-01-09-7C

Ready

Configurs 1/0 Modules & Points | Configure PID Loops | Canfigure Assemblies | Verify |

Modules and Points | Type ‘ Feature / Scaling | Uitz

‘Watchdog

Add
_oeee |
=R

E=pand Al
Collapse &ll

When installed and first turned on, an Opto 22 device sends out a BootP broadcast requesting an IP address.
EtherNet/IP Configurator discovers each Opto 22 device on your network broadcasting a BootP request and
lists the devices in the device tree.
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Discovered Devices —f—

CHAPTER 3: GETTING STARTED

‘1. EtherNet/IP Configurator, - Delta

File Edit Tools WYiew Help
DEE ?
—|- Add new device...
BROptn 22 110 &
+-Opto 22 /O B MAC addresses
—|- Discovered Devices
00-A0-30-00-C1-48
00-A0-30-01-51-08
00-A0-30-01-51-0F

Like all Opto 22 Ethernet-based controllers and brains, each of the discovered devices has a unique hardware
Media Access Control (MAC) address, which is displayed in the device list.

In order to add a discovered device to a configuration so that it can communicate on the network, you must
give the device a name, a valid IP address, and a subnet mask.

To add a discovered device:

2.

Make sure the device is connected to the network and turned on.

The device now broadcasts a BootP request for its configuration.

Your SNAP-PAC-EBT is identified by its MAC address, also written on a label attached to the side of the
controller's housing. (The MAC addresses of Opto 22 devices begin with 00.a0.3d.) If no devices are listed
under Discovered Devices, turn your Opto 22 device off and then turn it on again.

When the MAC address of the discovered device appears under Discovered Devices, double-click the
MAC address.

#8 Untitled* - EtherNet/IP Configu
File Edit Tools ‘iew Help
=y = 7
- Add new device...

+- Unnamed_Device

00-40-30-01-51-E:

CAUTION: EtherNet/IP Configurator lists ALL Opto 22 devices sending BootP or DHCP broadcasts. Assign IP
addresses only to the ones you know are yours!

The Assign IP Address dialog box appears.

Assign IP Address to 00-A0-3D-00-C... [E|

IP Address: | 0 0 0
SubretMask: | 0 . 0 . 0 . O
Gateway Address: | 0 0 0 0
DNSAddess | 0 . 0 . 0 . O

Ok | Cancel |

Enter the IP Address and the Subnet Mask for the device. If it will be talking to a device on another
subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave the gateway
address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 field blank.

I04AB User's Guide 1



CONFIGURING I/0 MODULES AND POINTS

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on, must
have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware
failures. If you don't know which IP addresses are safe to use, check with your system administrator.

5. When the IP address, subnet mask, and other fields are correct, click OK.

The Name This Device dialog box appears with the Device Type, IP Address and Port filled in
automatically.

Mame This Device [g|

Device Name: |

Drescription: |

Device Type: | J

IP Address: |

Port:

Temperature: ¢ Fahrenheit  © Celsiuz

watchdoo: * No  ‘Yes

0] | Cancel

6. Atminimum, enter a Device Name.
You can also enter a description, select the temperature type, and whether you want to use a watchdog.
Temperature. Choose whether temperatures will be handled in Fahrenheit or Celsius.

Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you select
Yes, a new field appears; enter the Watchdog timeout value (in seconds). The default timeout is 0.5
seconds.

NOTE: Ifyou want to enable Watchdog on a point, make sure to enable it here at the point level as well.

7. (lick OKto confirm the changes.
The new device appears in the device tree.

= System IV* - EtherNet/IP Config

File Edit Tools Wiew Help
(= =] ?
- &dd new device...

+- Unnamed_Device

New device —]

Discovered Devices

CONFIGURING I/0 MODULES AND POINTS

For both implicit and explicit messaging, once you have added a device, you need to configure its modules
and points as described in the following sections:

«  "Configuring Digital Points” (below)
«  "Configuring Analog Points”on page 15
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Configuring Digital Points

CHAPTER 3: GETTING STARTED

Use the following steps to configure digital points on all 4-channel and high-density SNAP digital modules.
1. In EtherNet/IP Configurator, click the Configure I/0O Modules & Points tab.

8 Untitled - EtherNet/IP Configurator

File Edit Tools Miew Help

0w = 4

- Add new device...
+- Unnamed_Device

Configure ”E%DCMES & Points ] Configure PID Loops ] Configure Assemblies] Yerify ]

-|- Discovered Devices

00-A0-30-01-75-69 Modules and Points

Type -
Add...

Expand All

Collapze All

L

Feady

LM

2. Double-click the number that represents the digital module’s position on the rack. For help, see

“Referencing 1/0 Points on SNAP PAC Racks”on page 93.

4 Add Module

Tope:

Digital [nput
Digital Output
Analog Input
Analog Output

Madule:

5 10 )
SHAPIDCE-FAST: 25-16VDC
SHAPIDCE-FAST-A 18- 32VDC
SHaPIDCED: 25-28VDC
SHAPIDCEMA: 10 - 32 YDCAAL M an duta Switch
SHAP-IDCE-5W: Dy Contact Switch
SHaPIDCEG: 4 - 24WDE

SHAPIDCEG: 35 - TR WACADC
SHAPIDCE-HT: 15- 32%DC
SHAP-DCE-5W-NC: Diy Contact Switch
SHAPIDCEFM: 10 - 32VDC
SHaPIDCEDFM: 25 - 28%DC
SHaPIDC-32:10- 3200
SHaPIDC-16:10- 3200

Generic Digital Input

SHAPIACE: 90 - 140WDCAMLT
SHAP1ACES: 180 - 280 WD CAMLL
SHAP1ACEMA: A0 - 140 VD CAAL Mandbuto Switch
SHAPIACEFR: 30 - 140 VDCAALC
SHAPIACEAFM: 180 - 280 VDCAYALC
SHAPHAC-1E 90 - 140WDCAMC
SHAPHAC-A-16 180 - 280VDCAMC

Ok | Cancel
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CONFIGURING I/0 MODULES AND POINTS

3. Inthe Add Module dialog box, choose the module type and then the exact module part number from

the lists. Click OK.

4. Backin the Configure I/O Modules & Points tab, click the plus sign next to the new module to expand it.
Notice that the module icon is color-coded to reflect the type of module being configured: white for
digital DC input, red for digital DC output, yellow for digital AC input, and black for digital AC output.

Module icon Configurs 140 Modules & Paints I Configure PID Loops] Configure Assemblies] Verify ]

odules and Paints
s=m Mg (00] SHAP-IDCS: 10 - 32 JAC Digital Input

Expand or collapse points on
the module by clicking the +
or - sign in the box.

Points

5. Double-click the point you want to configure to open the Add Digital Point dialog box.

Add Digital Point X
Mame: | I A
Description: | - B
Type: —= C
Module: | J
Features: |None _:,— —D
Watchdog: & Mo E
Ok | Cancel | Help

6. Complete the fields as follows:

Features / Subty...

il

Delete

Modify

Expand Al

Collapse all

A Name: Enter a name for the point. The name must start with a letter and may contain letters,

numbers, and underscores. Spaces are converted to underscores.

B Description: (Optional) Enter a description of the point.

C Type, Module: Type and module are already filled in for you.

D Features: To use a feature of the module, choose it from the drop-down list. For information about
the available features, see “Using I/0 Point Features”on page 91.

E Watchdog: (Output modules only) To configure a status (On or Off) the point should be set to if the

Watchdog timer on this device expires, click Yes and choose On or Off from the drop-down list. In
order for this to take effect, make sure Watchdog is enabled at the device level. To do this,
double-click the device in the device tree to open the Modify Device Information dialog. Select Yes

for Watchdog, choose a timeout, and then click OK.
7. When you have completed the fields, click OK.
The new point appears in the list.
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Configure |/0 Modules & Paints | Configure PID Loops ] Configure .-’-\ssemblies] Werify I

Modules and Points | Type | Features / Subty.. | Lritz | En.
= [ﬂ [00] SHAP-IDCE: 10 - 32 WVDCAMLC Digital Input |
et 0 Pump_1_Status I T .
Delete

Modify

Expand Al
Collapsze all

8. To configure more digital points, repeat the steps. To configure analog points, see the next section.
Configuring Analog Points

Use the following steps to configure analog points on all SNAP analog modules supported by the device.

1. Inthe Configure I/0 Modules & Points tab, double-click the number that represents the analog module’s
position on the rack. For help, see “Referencing I/0 Points on SNAP PAC Racks” on page 93.

%= Add Module [x)

Tupe:

Diigital lnput
Digital Output

Analog Output

SHAP-AICTD
SHAP-AICTD-4
SHAP-AICTD-8
SHAP-AILC
SHAP-AILC-2
SHAP-AIMA
SHAP-AIMA
SHAP-AIMa-SRC
SHAP-AIMA-4
SHAP-AIMA-S
SHAP-AIMA-32
SHAP-AIMAZ-
SHAP-AIMY-4 o
SHAP-AIMY2-4
SHAP-AIPM
SHAP-AIRATE
SHAP-AIRTD
SHAP-AITM
SHAP-AITM-
SHAP-AITM2
SHAP-AITM2-

Ok | Cancel |

4

2. Inthe Add Module dialog box, choose Analog Input or Analog Output, and then choose the exact
module part number from the list. Click OK.

3. Inthe Configure I/O Modules & Points tab, click the plus sign next to the new module to expand it. Notice
that the module icon is color-coded to reflect the type of module being configured: blue for analog
input, green for analog output.
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Configure |/0 Modules & Paints | Configure PID Loops] Configure .&ssemblies] Verify ]

Module icon

—\. [01]

Expand or collapse points on
the module by clicking the +
or - sign in the box.

SHA

Analog lnput

tModules and Points | Type | Features / Subty. . | Unitz | -
= [3 [00] SMAPADCS: 10 - 32 WDCAAL Digital Input
Ilﬂ 0 Pump_1_Statuz MNaone

Delete

Modify

Expand Al

B Bl

Collapse all

4. Double-click the point you want to configure.
Add Analog Point 3
M ame: || —A
Description: | N B
Type: Lo C
Module:  |SMAP-Iv-; -10- +10%DC B4
[T Units: VDL
e R €
D Zero Scale: |10
— | et F
| | Full Scale: |10
“Watchdog: + MNo G
QK | Caticel | Help
5. Complete the fields as follows:

A Name: Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B Description: (Optional) Enter a description of the point.

C Type, Module: Type and module are inserted for you. You may be able to choose a different range
from the drop-down list.

D Units, Scale: Units and scaling for this module. See “Using Custom Scaling”on page 17.

E Scaling Default: To return the unit's zero-scale value and full-scale value to the defaults for the
module, click Default.

F Scaling Custom: To assign custom units and values to the module, click Custom. For example, you
could scale the voltage range of a-10 to +10 VDC module to be interpreted as engineering units of
liters per second instead of volts. See “Using Custom Scaling”on page 17.

G Watchdog: (Outputs only) To configure a value this point should be set to if the Watchdog timer on
this device expires, click Yes and enter the value. In order for this to take effect, make sure Watchdog
is enabled at the device level. To do this, double-click the device in the device tree to open the Modify
Device Information dialog. Select Yes for Watchdog, choose a timeout, and then click OK.

6. When you have completed the fields, click OK.

16

Points //

The new point is added.
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Configure |/0 Modules & Paints | Configure PID Loops ] Configure .-’-\ssemblies] Werify I

= Bl [O01] SMAP-AR
|

0 Floweter_&

Modules and Points | Type | Features / Subty.. | Lritz
= [ﬁ [00] SMAP-IDCS: 10 - 32 WD AL Digital lnput
Ilﬂ 0 Purmp_1_Status MNaone
Analag Input

Delete

Modify

Expand Al

-10 - +10%DC

B Bl

Collapsze all

Point types and features are shown in the Features/Subtype column.

7.
page 13.

Using Custom Scaling

To add more analog points, repeat the steps. To add digital points, see “Configuring Digital Points”on

Analog modules can be set to show something other than the actual inputs or outputs. For example, you
could scale the readings of a -10 to +10 VDC input point to measure its input as zero liters per second when
the real-world reading is zero VDC, and 1000 liters per second when the real-world reading is five VDC.

NOTE: Custom scaling has no effect on the resolution or accuracy of the module.

1. Inthe Add Analog Point dialog box, click the Custom button in the Scaling area to open the Scale Analog

Readings dialog box.

Scale Analog Readings

A — L Scaled Units: |Liters per second
Lower Value
B—f— actual |0 [vDC
C—1— s5caled |EI |Liters per 3EC0
Upper W alue
D—3— acuat |5 DL
E | Scaled: |1IJDD |Liters pEr S28C0
Ok | Cancel | Help |

This example shows units scaled to liters per
second. Atan actual input of 0 VDG, the point
will show 0 liters per second. At an actual
input of 5 VDC, the point will show 1000 liters
per second.

%]

2. Complete the fields as follows:

A
B

Scaled Units: Enter new engineering units for the module. The example uses liters per second.
Actual Lower Value: Enter the actual real-world lower value that the scaled lower value corresponds

to. Note that inputs typically have under-range capability, which means you can specify a lower
actual value that is less than the zero-scale value. Outputs do not have under-range capability.

Scaled Lower Value: Enter the new scaled lower value. This value can be any floating point value.
Actual Upper Value: Enter the actual real-world upper value that the scaled upper value

corresponds to. For inputs, you can specify an upper actual value greater than the full-scale value.
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NTS

E Scaled Upper Value: Enter the new scaled upper value. This value can be any floating point value
greater than the scaled lower value. This example uses 1000, which scales the output to 1000 liters

per sec
3. Click OK.

ond when its actual reading is 5 VDC.

The new custom-scaled units appear in the Add Analog Point dialog box.

Add Analog Point =3
Mame: |F|owmeter_.t’-‘«
Diezcription: |
Type:
Module:  |SMAP-AIE A10- +10VDC [Scalable] = |
. - Scaling
Units; Liters per second
Drefault
Zera Scale: |-2000 \-\
Custamn...
Full Scale: 2000 _
Watchdog: « Mo
Ok Cancel Help

Notice the new units of liters per second and the new
minimum-scale (“Zero Scale”) and maximum-scale
(“Full Scale”) values of -2000 and +2000. The example
connects a sensor with a range of 0-1000 liters per
second, but an output of only 0-5 volts, to a SNAP-AIV
module with an output of -10 to +10 volts. The figures
shown in this dialog box reflect the total possible
range of the module, not the sensor.

Custom scale Modules
(Liters/sec) scale (VDQ)
Possible low -2000 -10
value for module
-1000 -5
Upper & lower 0 =(0
vglues entered in 1000 _|s
dialog box
Possible high 2000 10
value for module

NOTE: On a bipolar module (for example, -10 VDC to +10 VDC), the minimum scale is always zero EU, not a
negative number.
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4: Setting Up Implicit Messaging

This chapter describes how to use EtherNet/IP Configurator and RSLogix 5000 software to set up implicit
messaging between an Allen-Bradley controller and Opto 22 remote /0. If you want to set up explicit
messaging, see “5: Setting Up Explicit Messaging” on page 29. For help in choosing a messaging type, see
“Choosing the Messaging Type”on page 7.

Before you begin, make sure you have done the following things:

« Installed your Opto 22 device and modules according to the instructions that came with the device and
modules

«  Added your Opto 22 device using EtherNet/IP Configurator (see “Adding an Opto 22 Device” on page 10)
«  Configured the Opto 22 I/0 module and points (see “Configuring I/O Modules and Points”on page 12)
To set up implicit messaging you must use EtherNet/IP Configurator to create input and output assemblies. An
assembly provides the format for the implicit message packet that includes the information for the point or

points you are interested in. Once you have created the assemblies you will use RSLogix 5000 to complete the
setup.

For a list of the basic things you will need, see “What You Will Need” on page 9.

IN THIS CHAPTER

Creating an Input Assembly 19
Creating an Output Assembly 22
Configuring RSLogix for Implicit Messaging 24

CREATING AN INPUT ASSEMBLY

1. In EtherNet/IP Configurator, click the Configure Assemblies tab, and then select an assembly instance
number, for example assembly instance 100. Each assembly instance created requires a unique number.
Unused assembly numbers have a white background.
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CREATING AN INPUT ASSEMBLY

Configure 140 Modules & Points | Configure PID Loops  Configure Assemblies ]Verif}l ]

Azzembly Instance; 100
[100p 101 [ 102 [ 103 | 104 | 105 [ 106 [ 107 [ 108 | 109 | 110 [ 111 [ 112 [ 113 ] 114
Desc%

Azzembly Members:

# | DINT | Bit | Size [ Class Instance

ion:

e [l

1o o~ AT amE L

2. (lick Add to open the Add Assembly Member dialog box.

Add Assembly Member

x]

Dezcription:
[
Class: Inztance Infarmation: Attribute:
= |rput Pt
Dizcrete Output Paint " Point Mame FeatureSelact
Analog lnput Point FeatureE nable
Analog Output Paint | J Feature\falue
Load Cell Input ClearFeaturet/alue
Scratchpad DINT OnLatch
Scratchpad REAL y OffLatch
Seratchpad STRING Madule: |0 =l

o
Pulze And TPO Generator .
Ramp Contrallzr Paint; |0 -
PID Loop Cantraller

Cormmunication ‘W atchdog
Pad

Ok | Cancel

3. Select a class such Discrete Input Point.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the CIP classes,
all of which are available through explicit messaging. For information on the CIP classes and attributes,
see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.

4. Under Instance Information, select a point that you have configured. Otherwise, you can assign an
assembly member to a specific module and point.

20 |04AB User's Guide


https://www.opto22.com/support/resources-tools/documents/1770-ethernet-ip-for-snap-pac-protocol-guide

CHAPTER 4: SETTING UP IMPLICIT MESSAGING

Add Assembly Member El
Description:
Class: Inztance Information: Attribute:
ke [nput Point
Dizcrete Output Point " Point Mame FeatureSelect
Ainalog Input Point FeatureE nable
Ainalog Output Point |Phgt0_Sensg|' {Mad:00 Pt:Dﬂ Feature'/alue
Load Cell Input ClearFeaturet alue
Scratchpad DINT OrnLatch
Scratchpad REAL ) OffLatch
Scratchpad STRING e =
Pulze And TPO Generator ; ,—_|
Famp Contraller Point:

PID Loop Controller
Communication ‘W atchdog
Pad

Ok, | Cancel

5. Under Attribute, select an item in the list.

The attribute list allows you to define what information from each point you want to have passed in the
implicit message. In addition to value readings, you can get other data, such as the minimum or
maximum value for an analog input/output.

6. Click OK and follow any directions that appear for the class.
For example, the Fill Module dialog box appears for Discrete Input Point and Analog Input Point.

Fill Module

“would pou like to fill the rezt of the module with the same type of point?

* Yezs Mo

How many pointz does this module have? |4 -

7. Click OK.
8. Continue to add elements as necessary.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add padding.

9. Toadd a pad, click the Add button to open the Add/Modify dialog box.
10. Under Class, select Pad, enter the size of the pad (for example, 28), and click OK.
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Add Assembly Member

X

Description:

Class: Inztance Information: Attribute:
Digcrete Input Point

Dizcrete Output Paint Size In Bits: |28

Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Ramp Controller

FID Loop Controller

Communication Watchdoi
Ok, | Cancel |

The pad appears as the last member of element 0 to complete the 32-bit word, also called a DINT. You
can add up to 125 input DINTs.

When you have completed an input assembly for implicit messaging, go to the next section to create an
output assembly.

CREATING AN OUTPUT ASSEMBLY

Creating an output assembly is similar to creating an input assembly.

1. On the Configure Assemblies tab, click an assembly instance number other than the one used for the
input assembly, for example assembly instance 101.

Notice that the assembly numbers you've already used have a green background.

Configure |/0 Modules & Points ] Configure PID Loops  Configure Assemblies ]Verif}l ]

Aszsembly Instance: 101

sz 103 [ 104 [ 105 [ 106 [ 107 [ 108 [109 [ 110 [ 111 [ 112 [ 113
b}

escription;

Azzembly Members:
# | DINT | Bit | Size | Class Instance

2. Select a class such Discrete Output Point.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the CIP classes,

all of which are available through explicit messaging. For information on the CIP classes and attributes,
see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.

3. Under Instance Information, select a point that you have configured. Otherwise, you can assign an
assembly member to a specific module and point.

4, Under Attribute, select an item in the list.
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Add Assembly Member, El

Description:

Class: Inztance Information: Attribute:

Dizcrete Input Point

te Dutput Paint {* Paint Nare Comrmw atchdogE nable
Analog Input F'oin_t Commw atchdogt alue
Analag Dutput Paint | Outside_Light (Mod:01 PO~ |

Load Cel Input Hutside Light lM':"im\ 03

Scratchpad DINT - el
Scratchpad REAL

Scratchpad STRING .. Modue: e

Pulze And TPO Generator

Ramp Controller Point: :‘
FID Loop Controller

Communication W atchdog

Pad

Ok, | Cancel |

The attribute list allows you to define what information from each point you want to have passed in the
implicit message. For example, in addition to writing a value to a point, you might want to change the
watchdog value or set high or low clamps on an analog point.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add padding.

To add a pad, click the Add button to open the Add/Modify dialog box.
Under Class, select Pad, enter the size of the pad (for example, 28), and click OK.

Add Assembly Member, fgl

Dezcription:

Clazs:

Instance Information: Attribute:

Dizcrete Input Paoint
Digcrete Output Point Size In Bits: |28
Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Fiamp Contraller

FID Loop Contraller

Communication W’atchdoi
[0 | Cancel |

The pad appears as the last member of element 0 to complete the 32-bit word (or DINT). You can add up
to 124 output DINTs.

When you've completed the output assembly instance, you are ready to download the configuration to
the Opto 22 device. This is also a good time to save the configuration.

To save the configuration, choose File > Save As. Then browse to an appropriate directory, name the file
(for example, Opto_l0O), and then click Save.

Before you download the configuration, it is helpful to check for errors on an assembly configuration
report.

a. Inthe device tree, select an Opto 22 device.
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‘r. EtherNet/IP. Configurator - Opt

Filz Edit Tools Wiew Help
(= = s
- Add new device...
Select an -
OptO 22 device +- SHapP_Pach

+- SHAP_PAC_S1
- Discovered Devices

00-A0-30-00-90-F5

b. From the Tools menu, choose Assembly Configuration Report. A text file opens showing the
configuration report.
9. To send the configuration to the device, choose Tools > Download Configuration to Opto 22 Device.
10. Inthe Download Configuration dialog box, select the device’s IP address, and then click Download.

Download Configuration to Opto 22 Device Ead
Name | D escription | Port Address List Downlaad
Opto_22_IRID 200 :

Clear Seftings
Cloze
Timeout [meec]:
¢ | B 10000

This completes the setup of the Opto 22 remote I/O for implicit messaging. In the next section, you will
configure communications with the Allen-Bradley controller.

CONFIGURING RSLOGIX FOR IMPLICIT MESSAGING

In this section you will use RSLogix 5000 to configure an Ethernet-enabled Allen-Bradley controller to

communicate with the remote Opto 22 I/0 you configured in the previous sections. The following instructions

show screens from version 17 of RSLogix 5000 software using a CompactLogix 1769-L32E PLC.

1. Open RSLogix 5000.

2. Select File > New.

3. Onthe New Controller dialog box, fill in the appropriate information for the Type, Revision, and Name
fields.
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New Controller

X

Cancel

Help

Yendor: Allen-Bradley
Type —— Tupe: 176332 Compactogix5332E Cantroller | 0K |
Revision — Revision: 17 -
I
Name —3 Mame: ||D=1J-‘«B
Dezcription;
| E
o=
Create In: |E:\HSLDgiH RO00NProjects

Browse...

J

Browse to the folder you want to use, and then click OK.

In the controller organizer, expand I/0 Configuration, Backplane, and 1769-L32E Ethernet Port LocalENB.

+ I—&B Ly
[ add-On-Defined
+-Lf Predefined
[ Module-Defined
[T Trends
=145 1} Configuration
Expand < - m Backplane, Compactlogix System
&I 1769-L32E IO44E
| - 1769-L32E Ethernet Port LocalEn
== Ethernet
ff CompactBus Local 3
< |

Right-click Ethernet and select New Module.
This module will be used to add the Opto 22 device.

Expand Communications in the controller organizer to open the Select Module dialog box.
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I Select Module r5_<|
todule Description Wendar

1769-L32E Etherne.. 10§100 Mbps Ethernat Port on CarmpactLogixS332E Allen-Bradley

1769-L35E Etherne.. 10§100 Mbps Ethernat Port on CormpactLogixS335E Allen-Bradley 1
1788-EN2DMIA 1788 Etherret ko Devicelet Linking Device allen-Bradley
L788-EMET A 1788 10/100 Mbps Ethernet Bridge, Twisted-Pair Media allen-Bradley
1788-EWEE/A 1788 10/100 Mbps Ethernet Bridge wEnhanced Web Sery., allen-Bradley
1794-AENT A 1794 107100 Mbps Ethernet Adapter, Twisted-Pair Media  Allen-Bradley
1794-4ENTIE 1794 107100 Mbps Ethernet Adapter, Twisted-Pair Media  Allen-Bradley
DrivelogizS730 Eth, .. 104100 Mbps Ethernet Port on DrivelogixS730 Allen-Bradley
ETHERMET-ERIDGE  @eneric Etherhet/IF CIP Bridge Allen-Bradley
Generic Ethernet Module k Allen-Bradley

Ethertet/IP SoftLogix5300 Etherlet)/TH Allen-Bradley —
PH-PSSCEMALA Ethernet Adapter, Twisted-Pair Media Parker Hannif

+ - Digital b
R ol

Find. | pddFavorte |

By Category By endaor I Favarites J

Ok | Cancel | Help |

8.  Scroll down to Generic Ethernet Module and then double-click it to open the New Module dialog box.

New Module [z|
Type: ETHERMET-MODULE Generic Ethernet Madule
“endor; Allen-Bradley
Farent: LocalENE
M ame: SNAP_IRID Cannection Parameters
Azzembly :
Description; Instance: Size:

Input; 100 2 J;I [32-hit)
101 1 __i:I [32-bit)
Caomm Format: |Data -DINT ﬂ : ; = i
3 Configuration; 254 0 :J, 8-bit
Address / Host Name = perf e

& |P Address: | 192168 .0 . 1

" Host Marne: | !
¥ Open Module Properties 0K | Cancel I Help

Olutput:

9. Enter or select the following information:
- Name: An appropriate name such Opto_IQO.

- Comm Format: Choose the format most appropriate for the implicit message data, usually Data - DINT
or Data - REAL.

NOTE: Once you select the Comm Format and then click OK, it cannot be changed.

— 1P Address: IP address of the Opto 22 device.

10. For the Input Assembly Instance and the Output Assembly Instance, enter the assembly instance
numbers you configured for the input and output assemblies in EtherNet/IP Configurator. For example,
you might have used 100 for the input assembly and 101 for the output assembly.

For the size of the input and output assemblies, enter the number of 32-bit words defined for each. For
example, if you entered one 32-bit word for the input assembly in EtherNet/IP Configurator as shown
here, you would enter 1 as the size of the input assembly on the New Module dialog box in RSLogix 5000.
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Azzembly Instance: 100

Configure 140 Modules & Points] Configure PID Loops  Configure Assemblies lVerif_l,J ]

(RSN RSN 10z (103 104 [ 105 [ 106 (107 [108 [ 109 [ N0 [ 111 (112 [ 113114 1

D escription:

Azzembly Members:

# | DINT | Bit | Size | Class

Inztance Attribute

]
1

a
a

]
1

1
Kl

Dizcrete [nput Pait
Pad

Flawmeter Mod:00 P00 Walue

The following example assembly from EtherNet/IP Configurator has three 32-bit words, so you would
enter a size of 3 in RSLogix 5000.

100

101

Description:

Azzembly Ingtance; 100

Configure |/0 Modules & Points] Configure PID Loops  Configure Assemblies ]Verify ]

102 | 103 | 104 | 105 | 106 | 107 | 108 {103 | 170 | 117 | 112 | 113 | 114 | 116

Azzembly Members:

# | DINT | Bit | Size | Class

Ihstance Altribuite

]

L P =

]

0
1
2

]

1
0
0

1
]l
32
2

DigcretelnputPaint
Pad
AnaloglnputPoint
DizcretelnputPaint

Phato_Sensor Mod:00 Pt Walue

Store_Temperature Mod:0..  Value
Emergency_Switch Mod:0..  Featurealue

EtherNet/IP Configurator indicates the size of the assembly instance at the bottom of the screen as

shown here.

Configure 1/0 Modules & Paoints | Configure PID Loops  Configure Assemblies ]Verify ]

Hzzembly Instance; 100

[N RN 102 [ 103 (104 [ 105 [ 106 [ 107 [108 [ 109 [ 110 [ 11 [ 112 [ 113 [ 114 [ 1

Diescription:

ALzzembly Members:

Instance

# | DiNT | Bit | Size | Class
0 0 0 1 Digcrete0utputPoint
1 0 1 1 Digcretel utputPoint
2 0 2 1 Dizcretel utputPaint
3 0 3 1 Digcrete0utputPoint
L] 1] 4 28 Fad
5 1 i] 16 AnalagDutputPaint
B 1 16 1B Pad
7 2 0 32 DigcretelnputPoint
<

Size of assembly ———— Instance Size: 3DINTs [125 Mas)

instance

Alarm Mod: 0T PO
Freezer_Door_Statu
Inzide_Light Mod:0 Delete
QOutzide_Light Mod:

Fd odify

)

Fuel_Display Mad:0

Mod:00 PLO0 j‘

11. For the Configuration fields, enter 102 for the Assembly Instance and 0 for the size.
These Configuration values are not used, but they must be entered.

NOTE: The Input Instance is an RSLogix READ assembly, and the Output Instance is an RSLogix WRITE assembly.
The Configuration values are not used, but they must be entered.

12. Click OK.
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The Module Properties dialog box opens showing the Connection tab for you to enter the Requested
Packet Interval (RPI). The RPIis basically the scan time of the Opto 22 device.

13. Setthe RPIto a reasonable value (range is 10-3200 ms), then click OK.

The Opto 22 remote I/0 has now been configured and added to the RSLogix 5000 software as a generic
Ethernet module.

14. Select Communications > Download to download the RSLogix program to the controller, and then click
Download in the next two dialog boxes that appear.

Once the download is complete, the program will run automatically on the controller.
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5: Setting Up Explicit Messaging

This chapter describes how to use the EtherNet/IP Configurator and RSLogix 5000 to implement explicit
messaging over EtherNet/IP in order to access data from SNAP PAC 1/0 and SNAP PAC controllers. If you want
to set up implicit messaging, see “4: Setting Up Implicit Messaging”on page 19. For help choosing a
messaging type, see “Choosing the Messaging Type”on page 7.

Opto 22's implementation of Allen-Bradley’s explicit messaging is an EtherNet/IP version of an earlier
messaging protocol, CIP Messaging over ControlNet. Similar in some ways to explicit messaging, CIP
messaging also used the MSG instruction. Along with implicit messaging, explicit messaging is supported on
controller platforms such the ControlLogix” and CompactLogix™. It is also supported on other Allen-Bradley
platforms that do not support implicit messaging.

For information on the objects available using explicit messaging in an I04AB system, see form 1770,
Ethernet/IP for SNAP PAC Protocol Guide.

For a list of the basic things you will need, see “What You Will Need”on page 9. Note that the examples in this
chapter are based on the 1/0 contained in a SNAP PAC Learning Center, but because essential parts are no
longer available, learning centers are now obsolete. However, it is not required that you have a Learning
Center to do the majority of the steps.

In this Chapter

Creating an Assembly Instance 29
Configuring an EtherNet/IP Module 35
Creating a MESSAGE Object 38
Adding the MSG Instruction 44
Configuring a MSG to Write an Assembly INStance ........ccoecvversees 46
Using User Data Types (UDTs) 48
Summary 48

CREATING AN ASSEMBLY INSTANCE

This section provides an example of how to use EtherNet/IP Configurator to configure modules and points on
an Opto 22 device such that the data can be accessed by the Allen-Bradley Logix architecture.

This section includes the following topics:

«  "Using EtherNet/IP Configurator to Add and Configure a SNAP-AICTD Module” on page 30
«  "Configuring the SNAP-AICTD Module Input Assembly”on page 31

«  "Configuring the SNAP-AOV27 Module Output Assembly”on page 33

»  “Downloading the Configuration to the SNAP PAC /0 Unit." on page 34
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CREATING AN ASSEMBLY INSTANCE

Using EtherNet/IP Configurator to Add and Configure a SNAP-AICTD Module

In this section you will use EtherNet/IP Configurator to import the Opto 22 SNAP PAC Learning Center's
ioCookies I/0 configuration and then configure the SNAP-AICTD module in slot 3 of the module configuration.

In order to configure the ioCookies 1/0 module configuration in EtherNet/IP Configurator, you must first use
PAC Control to export the I/0O configuration as an Opto Tag Database (.otg) file.

Creating an 1/0 Configuration Export File

1.

To open PAC Control:

In Windows, click the Windows Start button, and then click Opto 22 > PAC Control Basic 9.6 (or
PAC Control Pro 9.6).

In PAC Control, open the PAC Control version of the ioCookies strategy.

The ioCookies strategy is usually located on your local hard drive at Program Files > Opto22 > PAC Project
> Control Basic Examples > ioCookies.

Create a new I/0 unit for your SNAP PAC R-series controller and move all of the I/O points from the
existing 1/0 unit (Mixed_lO_Unit) to the new I/0 unit, as follows:

a. Choose Configure > 1/0 to open the Configure I/0 Units dialog box.

b. Select Mixed_IO_Unit, and then click the I/0 Points button to open the Configure I/0 Points dialog
box.

c. Expand Module 00, highlight the point in slot 0, and then click the Move To button to open the
Move Point dialog box.

d. Select the new I/0 unit, select the first available target channel, and then click OK.

e. Repeat this process for each point (highlighting the point and moving it to the new I/0 unit) until
you have moved all of the I/0 points to the new I/0 unit.

f.  Close all of the open dialog boxes in PAC Control.

In the strategy tree, right-click the old I/0 unit and choose Delete to remove it.

In the strategy tree, right-click the I/0 Units folder and choose Export from the pop-up menu.
The Export I/0 Units to an Opto Tag Database dialog box appears.

Navigate to the location where you want to place the export file. Type the file name, and click Save to
create the export file.

Importing the Configuration File into EtherNet/IP

1.

2.
3.

In the EtherNet/IP Configurator main window, click the Open button [1| or choose File > Open to open
the Open Tag Database dialog box.

Open Tag Database
Lok i |L‘f} Configuration Files j = £k EB-

File name: |D pto_22_Config.otg
Files of type: |Dpto Tag Databaze Files [*.ota) j Cancel

Locate the 1/0 configuration (otg) file and click Open to import the file.
Double-click the device name to open the Modify Device Definition dialog box.
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Double-click
device name

4.

| ioCookies_I0_Configuration® - EtherNet/IP Configurator

CHAPTER 5: SETTING UP EXPLICIT MESSAGING

=13

File Edt Tools Yiew Help
O0=H 7
= Add new device... - -
— + Configure 1/0 Modules & Points | Configure PID Loops I Configure Assemhlies] Werify ]
Discovered Devices
todules and Points | Tyvpe | Feature / Scali
# [ [00] SNAP-DCSD: 2.5 - 28%DC Drigital Input
+ - [01] SMAP-ODCESRC: 5 - BOVDLC Source  Digital Output
+ |ﬂ [02] SMAP-A0M-27 Analog Output
+ - [03] SMAP-AICTD Analog Input Madify
+ - [04] SMAP-AR Ainalog Input
Expand All
Collapze Al
4 *
Feady UM

Enter the correct IP address for the PAC R controller.

Modify Device Definition

Device Name: [SNAP_PAC_ID

Description: |

Enter the PACR's IP address

Device Type: |SN)1P—PAC—R2 j
IP &ddress: 10.183.57.100
Fort: 200
Temperature:  © Fahrenheit ™ Celsius
‘W atchdog: * Mo  Yes
()8 | Cancel |

This is important because the imported configuration will likely have the local loopback address for the
I/0 unit (127.0.0.1) instead of the IP address for the PAC R. In order to communicate with the PACR,
EtherNet/IP Configurator needs the device’s IP address.

Configuring the SNAP-AICTD Module Input Assembly

The input assembly’s role in this exercise is to read the temperature as a REAL (a 32-bit float).

In EtherNet/IP Configurator, open the ioCookies I/0O configuration as described in the previous section,
then expand the configuration for the SNAP-AICTD module in slot 3.

Notice that point 0 of slot 3 connects to the process temperature probe.

1.

2.
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#8 ioCookies_I0_Configuration - EtherNet/IP Configurator
File Edit Tools Wiew Help

O=H ?
= Add new device...
+- SNAP_PAC_IO Configure 1/0 Modules & Paints | Configure PID Loops] Canfigure Assemblies] Werify ]
Discovered Devices
Modules and Paints | Type | Featun =
+ |j [00] SMAPHDCED: 25 - 28%DC Digital Input

+ - [01] SMAP-ODCRSRLC: 5 - BOWDC Source  Digital Dutput

+ [ [02] SHAP-A0vV-27 Analog Output %
Analog Input Modify
i

+ gl (041 5NAP-AlY Analog Input Euand !
Collapse Al

1 v

Ready MM

3. (lick the Configure Assemblies tab, select assembly instance 100, and click the Add button to open the
Add Assembly Member dialog box.

4. Make the following selections:
—  (Class: Analog Input Point
- Instance Information: Module 3, Point 0
- Attribute: rvalue

Add Assembly Member

X

Description:

Class: Instance Information: Altribute:
Dizcrete Input Paint Walue
Dizcrete Dutput Point " Point Mame Minirmumry alue
i ]
LowS caledE ngineeringU nits

| J I awimurnrty slue
HighS caledE ngineering nits
Madule: |3 - ggﬁ?t
i R .
Pulze &nd TPO Generator e ’—_| AveragingFilterweight
Famp Controller Paint: o h
FID Loop Controller

Communication W atchdog
Pad

(] 8 | Cancel

5. Click OK.

As shown below, the assembly instance 100 has a single value, the rValue of module 3, point 0. This

corresponds to the Process Temperature input, which is the first of two channels on the SNAP-AICTD
module.
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File Edit Tools Wiew Help

O=HE

?

= Add new device...
+ SHAP_PAC_ID
Discovered Devices

Configure 140 Modules & Points | Configure PID Loops  Configure Assemblies l\u"erify ]

Azzembly Ingtance: 100

101|102 | 103 104 [ 105 | 106 | 107 | 108 | 103 | 110 [ 111 | 112 | 113 | 114 | 115

Description:

Aszzembly Members:
# | DINT | Bit | Size | Class

Instance Altribute

] ] ] 32

Analog Input Paint

ailvenTemperature ... Malue Add

i

MM

Configuring the SNAP-AOV27 Module Output Assembly

1.

2,
3.

Click the Configure I/0 Modules & Points tab and expand the configuration for the SNAP-AOV-27 module

in slot 2.

#8 ioCookies_I0_Configuration* - EtherNet/IP Configurator,
File Edit Tools Wiew Help

O=HE

?

= Add new device...
+ SHAP_PAC_ID
Discovered Devices

Configure 1/0 Modules & Paints | Configure PID Loops] Configure Assemblies] Werify ]

Modules and Paints

| Type | Feature / Scalir «

+ |j [00] SMAPADCSD: 25 - 28%DC

+ - [01] SMAP-ODCRSRLC: 5 - BOWDC Source  Digital Dutput

Diigital Input

= [ [02] SNAPAOY-27 #inalog Output ekt |
=4 o0 smperatu k Modify
OM_, 1 aoConveyorSpeedContral
+ gl [03]SNAP-AICTD Analog Input Eoardal
+! - [04] SMAP-AIY Analog Input P
Collapse Al
| W[
< =
Ready UM

Click the Configure Assemblies tab, select assembly instance 101, and then click the Add button.
On the Add Assembly Member dialog box, make the following selections:
—  Class: Analog Output Point

— Instance Information: Module 2, Point 0

- Attribute: rValue
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34

Add Assembly Member rz|
Description:
Class: Instance Information: Altribute:
Dizcrete Input Paint Walue
Dizcrete Dutput Point " Point Mame Commw atchdogE nable
Analog [nput Point Commi atchdogh alue
Analog Output Paoint | J
Load Cell Input LowerS caledE ngineeringUnits
Scratchpad DINT UpperS caledE ngineeringUnits
Scratchpad REAL : LowClamp
Scratchpad STRING 5 s | = HighClamp
Fulse And TPO Generator . ’—_|
Famp Controller Paint: o h

FID Loop Controller
Communication W atchdog
Pad

(] 8 | Cancel

4. C(lick OK.

5. On the Fill Module dialog box, select No, and then click OK.
This rvalue will be a type REAL, just like the analog input.

#8 ioCookies_I0_Configuration* - EtherNet/IP Configurator,
File Edit Tools Wew Help

O=H ?
= Add new device... - -
+- SNAP_PAC_IO Configure 1/0 Modules & Paints | Configure PID Loops — Configure Assemblies l\u"erify ]

Discovered Devices
Azzembly Instance: 101

102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 ) 117 [ 112 | 113 | 114 | 115

Description:

Aszzembly Members:

#t | DINT [ Bit | Size | Class Instance Attribute
1] 1] 1] 32 Analog Dutput P...  aoOvenTemperatureC...  ialue Add

Delete
Modify

MM

Ready

Downloading the Configuration to the SNAP PAC I/0 Unit.

1. Choose Tools > Download Configuration to Opto 22 Device to open the Download Configuration dialog
box.

2. [Ifthisis the first time you are downloading an EtherNet/IP configuration, click the Clear Settings button
to erase all prior configurations, reset the PAC R to its factory default settings, and restart the I/0 unit.
3. (lickthe Download button to download the new configuration.
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38 Download Configuration to Opto 22 Device

Mame | Diescription | Port Address List | Download I
SMNAP_PAC 10 2001 10.192.54.115
Clear Settings |

Cloze |

Timeout [meec]:

<l i ]l, I‘IDDDD << Details |

Configuring Device: 10.192.54.115
12 paints successfully configured.
16 of 16 Assembly Instances successfully configured.
Configuration saved to flash

Device: 10.192.54.115 Complete

When the configuration has been downloaded successfully to the device, you are ready to configure an
EtherNet/IP module using RSLogix.

CONFIGURING AN ETHERNET/IP MODULE

The instructions in this example exercise are primarily for a ControlLogix 1756-L61. However, you can also use
a Compactlogix 1769-L32E. Any differences for the 1769-132E are included.

1. Create a new RSLogix project named “Explicit_Messaging.”

2. For Controllogix, select the 1/0 Configuration folder in the controller organizer, and manually add an
EtherNet/IP interface.

The interface is added to the I/0 configuration folder.

Logix 5000 - Explicit_Messaging [1756-161]

File Edit WYiew Search Logic Communications Tools Window Help

al=dl 2| 58| o] _ o &l w [E vEl @l e
Offline 0. 7 RUN | ot [<nones s
Mo Forces ». ™ ok <4 | - I = ;IJI
Mo E dits g.'::ﬁ? ﬂ |—||||:|'|||Eﬂ| -H—l-M—l-()—l-(U)-l-(L)'l ﬂ
Redundancy L) ll 4 | 2 I\ Favorites £ Add-On A Safety A Slarms £ Bit £ TimeriCi

[:l Controller Explicit_Messaging
[+ Tasks

23 Motion Groups

23 Add-0n Instructions

[ Data Types

= E8 1756 Backplane, 1756-A10
e E{I [0] 1756-L61 Explict_Messaging

Ready
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For a CompactlLogix 1769-L32E PLC, when you create a new project in RSLogix, an Ethernet interface
named “LocalENB"is automatically created at slot 1.

Logix 5000 - Explicit_Messaging [1769-L32E]

File Edit WYiew Search Logic Communications Tools Window Help

ol 2| &R o] = &lnm e e el [0

Offline [, T RUN E| Path: |<n0ne> ;Iﬂl
Mo Forces b ::DK i 1
No Edits a l_ﬁ,’;T KIS L= =0 T 2 B O o

f | i | 2 I\ Favorites £ Add-On A Safety A Slarms £ Bit £ TimeriCi

L

[:l Controller Explicit_Messaging
0 (0 Tasks
(23 Mation Groups
23 add-on Instructions
3 Data Types
- [13 Trends
=15 1} Canfiguration
Em Backplane, CompactLogix System
{0 1769-L32E Explicit_Messaging

- CompactBus Lacal

(Create Examine On instruction

)

In this example, there is a 1756-ENBT/A (Revision 3.9) in Slot 1 of the Logix chassis. You will need this
information to complete the next set of dialogs.

3. Toadd the 1756-ENBT/A, right-click the 1/0 Configuration folder and choose New Module. .. from the
popup menu to open the Select Module dialog box.

4., Expand the Communications group, select the 1756-ENBT/A adapter, and click OK.

M Select Module

Select the Module |Descﬂ:tion |Vend0r |
1756-ENBT/A 1756 10/100 Mbps Ethernet Bridge, Twisted-Pair Media  Allen-Bradley »
adapter 1756 10/100 Mbps Ethernet Eridge, ed-P: a b |
1756 Ethernet Communication Interface Allen-Eradley
1756-EMNET/E 1756 Ethernet Communication Interface Allen-Eradley
- 1756-EWEB/A 1756 10§100 Mbps Ethernet Bridge w/Enhanced Web Serv.. Allen-Bradley
1756-SYMNCH A Synchlink Interface Allen-Eradley
[+~ Controllers
[+ Digital
[+ Drives
[+ Mation =
[#- Other
[+ Specialty -
bl
KN I
Eind.. | AddFavaie |
By Category By Wendor Favorites I
QK I Cancel | Help |
)

5. Inthe Select Major Revision dialog box that appears, select the major revision of the 1756-ENBT/A
module, which is 3 for the module used in this example.
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Select Major Revision

Select major revision for new 1756-EMBT 44
module beihg created.

Major Revision: P =
0K | Cancel | Help |

6. Click OKto open the New Module dialog box.

New Module rz|
Type: 17EE-EMBT 44 1756 10100 Mbpz Ethernet Bridge, -
Twisted-Pair Media
endor: Allen-Bradley
Parent: Local
Address / Host Name
Mame: |

Description: + |P Address: R X i
" Host Mame:

Slat: 1 3:
Revizion: 3 - 1 3: Electronic Keying: | Compatible Keying -

Iv Open Module Properties 0K, | Cancel Help

7. Enteror select the following:

Name: ENBTA

Description: The 1756 ENBT/A in slot 1

Slot: 1

Revision (minor): 9.

Recall that our EtherNet/IP module has a revision of 3.9. The 9 is the minor revision number.

The other parameters are not necessary, so leave the other fields blank. The completed dialog box should

look like this:
New Module fg|
Type: 1756-EMBT 44 1756 10100 Mbps Ethertet Bridge. -
Twisted-Fair Media
Wendor: Lllen-Bradley
Parent: Local
Wi |ENET.-’-‘« Address / Host Mame
o = 5
Deseription:  [The 1756 ENBT /& in slot 1 IP addess: |
™ Host Marne: |
Slot: 1 —
Bevision: 3 B | — Electranic Keying: |Eompatible Keying j

[¥ Open Module Properties K | Cancel Help
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8. (lick OK.
The RSLogix window should now look like this:

¥ RSLogix 5000 - Fxplicit_Messaging [1756-1 61]*

Edit Wiew Search Logic Communications Tools Wwindow  Help

Bl & & o] RN ||
Offline f. & RUN E *;: Path: |<nona>

Mo Forces . EDK

Mo Edits g\, rﬁ.’gT J | | ‘ | | | ‘

-] 8|

4
Il i

4.7 Controller Explicit_Messaging
+- [0 Tasks
+-[C7 Motion Groups
(23 Add-0n Instructions
+-[7 Data Types
[ Trends
-1+ IfO Configuration
=i 1756 Backplane, 1756-410
E{I [0] 1756-L61 Explicit_Messaging
S6-EMET A EMNETA
&5 Ethernat

abEd LEIS

FRequested Packet Interval [RP): 3 ms

[ Inkibit Module

todule Fault

B Module Properties: Local:1 (1756-ENBT/A 3.9)

General Connection lHSNetW’nrx] Mndulelnfn] Part Ennfiguralinn] Port Diagnostics Eackplanel

[~ Major Faulk On Contraller |F Connection Fails while in Fun Mode

]

Cancel

Help

Description The 1756 ENBT/A in slot 1

Status Offling

hiodule Fautt

< | > Statuz: Offline
Ready

9. (lick OK again to close the Module Properties dialog box.

CREATING A MESSAGE OBJECT

In RSLogix, an explicit message is created using a MESSAGE tag.

1. In RSLogix 5000, open the controller organizer, right-click Controller Tags, and then choose New Tag.

=5 Contraller best
44 ControllerEgs
23 Controllersul Handlsr

23 Power-Up Handler
=53] Tasks

=58 MainTask

+ C& MainProgram

3 Unscheduled Programs
-5 Mation Groups

3 Ungrouped Axes

2. Inthe New Tag dialog box, enter or select the following:
- Name: Read Message
- Description: My read message for an MSG instruction
— Tag Type: Base
— Data Type: MESSAGE

38 |04AB User's Guide



CHAPTER 5: SETTING UP EXPLICIT MESSAGING

To select MESSAGE, click the Data Type button, _| to open the Select Data Type dialog box.

Mame: IHead_Message L‘
_ Carcel|
e |

Help

Description: My read message far Cancel

an MSG instruction

Tag Type: & Base
 Alias

" Produced |1 --_!-! COMSUMETS

" Consumed

Data Type: | - L

Scope:

0 Espiicit_Messaging Select Data Type

Style: I Data Types:

|MESSAGE 0K |
INT A Cancel !
INTEGRATOR i

LEAD_LAG

[EAD_LAG_SEC_DRDER Help |

MAXIMUM_CAPTLIRE

HINIMUM_CePTURE T
MOTION_GROUP
MOTION_INSTRUCTION
MOVING_AVERAGE

LamsARE T e TR R

~ Auray Dimension:

T AF Fb

L]

D D 1 Dim 2 ‘

The completed dialog box should look like this:

an MSG instruction

New Tag |_|
Mame: IFlead_M E53308 0K |
Description: by read message for Catcel |

Help

Tupe: IBase vI Connection... |

Aliaz For: I

[ata Type: IMESSAGE

Scope:; Iﬁl Ewplicit_Mezzaging

Shyle: I

¥ Open MESSAGE Configuration

3. Atthe bottom of the dialog box, select Open MESSAGE Configuration.
4, C(lick OKto close the New Tag dialog box and open the Message Configuration dialog box.
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5.

Message Configuration - Read_Message
Eonfiguration] Communicationl Tag l

Meszage Type:

Service

e |CuSle j Source Element: |

Source Length: m [Bytes)
Service ,_ . ,_
Code: lizz)) s (Hex) Destination j

Instance: Attribute:; [Hex)
Mew Tag...

) Enable 3 Enable %/ aiting O Start 2 Done Dane Length: 0
) Errar Code: Extended Error Code: ™ Timed Out €
Errar Path:
Errar Text:

Ok, | Cancel Help

Select Get Attribute Single for the Service Type.

Message Configuration - Read_Message

Configuration® l Communicatior| Tag |
Meszage Type: |CIF' Genenc j
Semvice |Dpan li = Source Element: -
e Dpe.n oFr‘mect ion J J
evice Fese A~ . =
Sorvice Device wWHO >, Sowrce Length: i} 3_ [Bytes]
il Get Attribute Single
Code: OpenConnection k J
Instance: |Parameter Bead
Parameter Write = e
PLS Awiz Configuration »
) Enable 3 Enable %/ aiting D Start 2 Done Dane Length: 0
) Eror Code: Extended Error Code: [~ Timed Out
Errar Path:
Error Text:
Ok, | Cancel | Apply Help

Notice that the Source Element and Source Length fields are now inactive.
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7.
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CHAPTER 5: SETTING UP EXPLICIT MESSAGING

Message Configuration - Read_Message

Canfiguration® l Communicationl Tag l

Meszage Type: |EIF' Genenc j
Service ; ; =
e |Get Aftribute Single J J
Service ,_ . ,_
Code: = W] Tz | (Hex) Destination j
Instance: Attribute:; [Hex) Mew Taq..

) Enable 3 Enable %/ aiting O Start 2 Done Dane Length: 0

) Errar Code: Extended Error Code: ™ Timed Out €

Errar Path:

Error Text:

Ok, | Cancel | Apply Help

Populate the Class, Attribute, and Instance fields as follows:

—  Class: 4 (Hex)

To Read an assembly instance is a Class 4 (Hexadecimal) Assembly operation.

—  Attribute: 3 (Hex)
This is a set Attribute option.
— Instance: 100

This is assembly instance 100 that you configured within the EtherNet/IP Configurator.
For more information on the Class and Attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol

Guide.

So far, the Message Configuration dialog box should look like this:

Message Configuration - Read_Message

Configuration” l Communication] Tag ]

Mezzage Type: |EIP Generic ﬂ
?E:g:ce |Gel Attribute Single j J
Service .
Cade: 8 [Hex] Class: |4 [Hex] Destination j
Instance: [100) Attribute: 3 [Hex) New Tag...

3 Enable <3 Enable wWailing ) Start 2 Dane Cone Length: O

2 Errar Code: Extended Error Code: [ Timed Out €

Errar Path:

Errar Text:

(u] 4 | Cancel | Apply | Help |

For the Destination, click the New Tag button to open the New Tag dialog box.

Create a variable with the following attributes:

—  Name: ICTD_Temperature
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— Data Type: REAL
- Scope: Explicit_Messaging
9. (lick OK to close the New Tag dialog box.

Mew Tag gl
Name: |IETD_T emperature oK.
Diescription: Cancel

Help
Type: ’m
Alias For: |
Data Type: |F!EAL D
Scope: |ﬁ| Explicit_Meszaging j
Shyle: | Float j
-

10. In the Destination field, select the new controller-scoped tag. In a MESSAGE object, the Source Element
and Destination must be controller-scoped tags.

ICTD_Temperature E ||

Mame |Data Type |Description | -
+|-Resd_Message MESSAGE My read message ..
ICTD_Temperature [ REAL |
L

Marne: ICTD_Temperakture
Data Type: REAL
Descripkion:

w
e
Show: Show Al >3

The completed Configuration tab should like this:

42 |04AB User's Guide



CHAPTER 5: SETTING UP EXPLICIT MESSAGING

Message Configuration - Read_Message

Comfiguration™ l Communicationl Tag l

Meszage Type: |EIF' Genenc j
Service i ; e
Tupe |Get Aftribute Single J J
Service ,_ . ,_
Code: c Hex] Class: 4 (He] Destination ICTD_Temperature H
Instance: (100 Adtribute:| 3 [Hex] New Tag.
) Enable 3 Enable %/ aiting O Start 2 Done Dane Length: 0
) Errar Code: Extended Error Code: ™ Timed Out €
Errar Path:
Error Text:
Ok, | Cancel Apply Help

11. Click the Communication tab.

Message Configuration - Read_Message

Configuration”  Communication ] Tag ]
Path: Browse...
'S 3
[~ Connected WV &
) Enable 3 Enable %/ aiting D Start 2 Done Dane Length: 0
) Eror Code: Extended Error Code: [~ Timed Out
Errar Path:
Error Text:
Ok, | Cancel | Apply | Help |

12. For a ControlLogix controller (1756-L61 with a 1756-ENBT/A) implementation, enter the communication

path, ENBTA, 2, 000.000.000.000, where:

—  ENBTA is the name of the EtherNet/IP communication module in slot 1 of our chassis.

- 2indicates this is an external message.

- 000.000.000.000 is the IP address of your PAC remote I/O unit.

Leave the Connected checkbox unchecked.
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Message Configuration -

Read_Message

Configuration”  Communication” l Tag ]

Path: |EMBTA, 2.10.129.45.46 Browse...

EMBTA, 2. 10129.45 46
5 I T
[~ Connected W «
) Enable 3 Enable %/ aiting O Start 2 Done Dane Length: 0
) Errar Code: Extended Error Code: ™ Timed Out €
Errar Path:
Errar Text:
Ok, | Cancel | Apply | Help |

For a CompactlLogix controller (1769-32E) with an embedded EtherNet/IP Communication module, the
path changes slightly. RSLogix automatically names the embedded EtherNet/IP module “LocalENB." All
other values of the path are the same.

Message Configuration -

Read_Message

Configuration®  Communication® l Tag |
Path; |LocalEMB. 2, 10.129.45.46 Browse...
cop [ = =
o L= T
[~ Connected WV -
) Enable 3 Enable %/ aiting D Start 2 Done Dane Length: 0
) Eror Code: Extended Error Code: [~ Timed Out
Errar Path:
Error Text:
ak | Cancel | Apply | Help

13. Click OKto close the di

ADDING THE MSG INSTRUCTION

alog box and save the module configuration.

An MSG instruction is used to trigger an explicit message. It starts only when the input rung condition
transitions from off to on, which is different than most other ladder instructions. Once the MSG is triggered,
the message occurs asynchronously. You do not need to keep the rung condition true to the MSG instruction
on. This will cause more logic time to be consumed each time the ladder runs.
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% RSLogix 5000 - Explicit_Messaging [1 756-161] - [MainProgram - MainRoutine]
Ef File Edit View Search Logic Communications Tools Window Help

Offline . 7 RUN

No Forces >, :: SET

No Edits a2 10
ey 00

=13 Controller Explicit_Messaging
[ controller Tags
(3 Controller Fault Handler
(23 Power-Up Handler
=& Tasks
= €@ MainTask
= C% MainProgram
[ Program Tags
& MainRoutine
(23 Unscheduled Programs
=3 Motion Groups.
(23 Ungrouped Axes
(3 Add-On Instructions
= &3 Data Types
(3@ User-Defined
+ O Strings
i, Add-On-Defined
# O, Predefined
£}, Module-Defined

~

-8 x
8|8 S| &% | -] 2laeE Mel /el
el B =1 %]
4 Sl ] lwlolo]o 2
ll 4| I\ Favorites { Add-On A Alarms A B A TmeriCourter A |
it 5555|635
&
A timer to control A timer to control A timer to control
the rate the the rate the the rate the
Read_Message is Read_Message is My read message for Read_Message is
toggled. toggled. a MSG instruction. toggled.
TON Read_Timer DN e | _Mow
0 ——| Timer On Delay —CEN, 1) Type - CIP Generic —<EN>——— Move -
Timer  Read_Timer |—(DN)— Message Control [E=] j<on>— Source ]
Preset 60000 & —ER>—
Accum 0« Dest Read_Timer.ACC
04

A timer to control
the rate the

Read_Message is Flag to indicate a

(3 Trends toggled. read is occurring.
= €3 1jO Configuration Read_Timer.DN Read_In_Progress
= €3 1756 Backplane, 1756-A10 u L
£ 1M 17561 A1 Fxnlicit Mass ¥ 3
< > MainRoutine J—
= — | A ainprowran ] »
Add Branch Rung 0 of 1 AP | A

In the example, a timer is used to control how often the MSG instruction is initiated. The timer creates a regular
interval to read or write to the remote I/Q. If the PLC and I/O are connected by very high bandwidth or reliable
wide area networking, you can set the timer to a reasonable interval (e.g. T second). However, if the wide area
networking is unreliable or fairly limited in bandwidth, set the timer for longer intervals such as 1 minute. The
longer timer allows the message to complete fully, even if it ends in an error in response to a communication
request.

The ladder must now inspect to see when the message operation is complete or has completed in error.
Check the Boolean attributes of either .DN or .ER to inspect whether the message is done or ended in an error.

% RSLogix 5000 - Explicit_Messaging [1756-L61]* - [MainProgram - MainRoutine*]

Ef File Edit View Search Logic Communications Tools Window Help

- |8 x
B I T L — VL T Y
Offline 1. T RUN — A et [<none> ~| &
NoForces >, F oK
NoEits s A H it | e O o »
LS l‘ 4| |\ Favorites { Add-On £ Alarms £ Bt £ TmmeriCourter £ |
=3 Controllr Explict_Messaing & | || 14| 5[5 [ =5 ] =5
[& Controller Tags
(33 Controller Fault Handler ~
(23 Power-Up Handler
=) 5 Tasks Flag to indicate a My read message for Flag to indicate a
G 8 MainTask read is occurring a MSG instruction. read is occurring
= C; MainProgram Read_In_Progress Read_Message. DN Read_In_Progress
Pragram Tags 1 It IF u
&= ?:‘T'th'ne My read message for
.Unsc eduled Programs a MSG instruction
= £ Motion Groups foad M i
(3 Ungrouped Axes ead_liessage.
(23 Add-On Instructions
=3 Data Types
i, User-Defined
+ Cﬂ Strings =}
()3 Add-On-Defined (End)
i Predefined
(9 Module-Defined
(3 Trends 0
= &3 1§0 Configuration
= B3 1756 Backplane, 1756-A10
0 1M1 17561 A1 Fxnlicit Mese ¥ v
< | = B _M?m‘Rouune‘I— T =
Ready Rung 0 of 1 APP /él

Rung 1 in this example is incomplete. When the XIC for Read_Message.DN closes, the explicit data read is
available. If the Explicit Message fails, the XIC for Read_Message.ER will close. In either case, the typical ladder
implementation will add additional logic to handle both successful and unsuccessful communications.
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The EtherNet/IP port is responsible for managing the TCP/IP communications of the explicit messaging.
According to Rockwell documentation the default unconnected timeout for an explicit message is 30
seconds. This value may be changed by modifying the “UnconnectedTimeout” member of the MESSAGE
object. This timeout should not be lower than five seconds on an optimally functioning network. Once an
explicit message is initiated, it cannot be stopped.

Here are both rungs of the ladder in a single screen view.

7 RSLogix 5000 - Explicit_Messaging [1756-L61]* - [MainProgram - MainRoutine*]

Ef File Edit View Search Logic Communications Tools Window Help - %
alS| 8 sme o < HaalF vel el
Offline 1. T RUN — Path: [<none> ~| &
No Forces >, FSET
No Edis E i 4 H= | 2
0.0 ‘M 4| |‘ Favortes )\ Add-On { Zlarms X Bt X TimeriCourter X
=€ Controller Explicit_Messaging i | | "‘I B ] }_,|
[ Controller Tags
(23 Controller Fault Handler -
(23 Power-Up Handler A timer to control A timer to control A timer to control
=3 Tasks the rate the the rate the the rate the
= £@ MainTask Read_Message is Read_Message is My read message for Read_Message is
= Cl MainProgram toggled. toggled. a MSG instruction. toggled.
Program Tags TON Read_Timer.DN MOV-
lainRoutine —1| Timer On I — e - eneric — Move —
[ MainRout 0 Timer On Delay LEN; Type-CP G —CEN>— [Tt
(33 unscheduled Programs Timer  Read_Timer [—(DN)>— Message Control Source 0
=13 Motion Groups Preset 60000 <CERD>—
(23 Ungrouped Axes Accum 04 Dest Read_Timer.ACC
(23 Add-On Instructions 04
=& Data Types
3, User-Defined
1 O, Strings
(i Add-On-Defined - “'Kr’;:e‘i::‘m'
) i Predefined § Read_Messageis  Flag to indicate a
Cp Module-Defined Soaled d i
B Trends 0ggl read is occurring
= £3 10 Configuration Read_Timer.DN Read_In_Progress
= €8 1756 Backplane, 1756-410 v L
9 [0] 1756-L61 Explicit_Messagil
= 8 [1]1756-EN2T/A ENBTA
@5 Ethernet Flag to indicate a My read message for Flag to indicate a
read is occurring a MSG instruction. read is occurring
Read_In_Progress Read_Message. DN Read_In_Progress
1 I} It ()
My read message for
P 5 a MSG instruction.
= — Read_Message ER
Type Ladder Diagram (Main) -~ ‘ }
Description v v
Enter operand of type MESSAGE Rung 0 of 1 APP | /_l
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A write assembly instance is also triggered by a timer, the same as a read assembly instance. You should not
use the message’s .ER and .DN attributes to trigger the next message operation because that can cause erratic
operation.

For more detailed information on creating a MESSSAGE object, see “Creating a MESSAGE Object”on page 38.

1. Inthe controller organizer, right-click Controller Tags, and choose New Tag.

2. Inthe New Tag dialog box, enter or select the following:

3. Atthe bottom of the dialog box, select Open MESSAGE Configuration.

Name: Write Message

Description: My read message for an MSG instruction

Tag Type: Base
Data Type: MESSAGE

4. C(lick OKto close the New Tag dialog box and open the Message Configuration dialog box.
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Message Configuration - Write_Message

Comfiguration™ l Communicationl Tag l

Meszage Type: |EIF' Genenc

=

Service | Set Attribute Single
Type:

ﬂ Source Element | Analog_ Output H

Source Length: 4 3; [Bytes)

Service .
Cade: 10 [Hex] Clasz |4 [Hex] J
Instance: (101 Atribute:| 3 [Hex) New Tag..

) Enable 3 Enable %/ aiting O Start 2 Done Dane Length: 0

) Errar Code: Extended Error Code: ™ Timed Out €

Errar Path:

Error Text:

Ok, | Cancel | Apply | Help |

Note that this message is an Opto 22 Object Model Class 0x04, attribute Oxe, and references the assembly

instance 101, where the outpu
Populate the fields as follows:

tis configured.

- Service Type: Set Attribute Single

- Class: 4 (Hex).

To Read an assembly instance is a Class 4 (Hexadecimal) Assembly operation.

—  Attribute: 3 (Hex)
This is a set Attribute opti
— Instance: 101

on.

For more information on the Class and Attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol

Guide.

Click on the Communication tab, and enter the same connection path as you did for the read message.

In order to make this an uncon

nected message, do not check the Connected box. Unconnected

messaging is the most efficient usage of TCP/IP encapsulation sessions in the Logix architecture.

Message Configuration - Write_Message

Configuration®  Communication® ] Tag |
Path; [EMBTA, 2,10.129.45.46 Browse. .
EMBTA, 2,10.129.45 46
& op ¢ I E =
o~ I—ZI l—:
[~ Connected v €
0 Enable 0 Enable W aiting 3 Start > Done Done Length: O
3 Ermor Code: Extended Error Code: [ Timed Out €
Errar Path:
Errar Text:
Ok | Cancel Apply Help

I04AB User's Guide 47


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3672
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3672

USING USER DATA TYPES (UDTS)

7. (lick OKto close the dialog box and save the module configuration.

USING USER DATA TYPES (UDTS)

SUMMARY

If you are using version 16 or newer of RSLogix 5000, UDTs offer Explicit Messaging the ability to access
assembly instance data with system meaningful attributes. By giving an attribute to each object within the
UDT, it is much easier understand what an assembly instance is.

For example, compare these two data statements:
«  PACO.Datal2]3
«  PACTurn_Conveyor_Off

The second statement is easier to understand than the first one. UDTs also permit mixed data types within a
single object; you can place REALs, DINTs, INTs, and BOOLs throughout the UDT. These values may be read or
written at will, as a single block of data.

When implementing digital I/O states to map to the EtherNet/IP Configurator's assembly instances, use the
BOOL data type in the UDT definition.

Remember that RSLogix 5000 will collect continuous BOOL definitions in the UDT into rounded 32-bit data
sizes. We recommend that you create a BOOL padding in the UDT, or else create a BOOL array of 32 values to
clearly indicate the extension of the BOOL data. This will avoid confusion to data mismatches between the
assembly instance and the MSG operation. To match this padding, the assembly instance configuration must
also have an appropriate pad to fill out a block of 32-bits.

Explicit messaging is simply a manual method of acquiring I/0 data. In combination with the EtherNet/IP
configurator, you are still able to read and write 1/0 values to configure or manipulate /O states.

Explicit messaging provides a way of accessing data upon demand, and it isn't necessarily difficult. It requires a
couple rungs of ladder to implement, a bit more effort than with implicit messaging.

The ladder controls when incoming and outgoing messaging occurs and the messaging occurs over TCP/IP.
This is very useful for implementing very remote or expansive network monitoring and control systems.

Explicit messaging is the only method for accessing SNAP PAC I/O in Allen-Bradley PLC lines outside of the
Logix 5000 family such as the MicrolLogix 1100 and 1400 families, which do not support implicit (I/0)
messaging.
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6: Connecting PAC Control and
Allen-Bradley Systems

In this chapter you'll learn how to connect a SNAP PAC controller with an Allen-Bradley ControlLogix
programmable logic controller (PLC) so that you can use either implicit or explicit messaging to exchange
data between these two automation systems.

Connecting the two systems includes the following activities:

«  Modifying the PAC Control strategy.

«  Creating and downloading EtherNet/IP assembly instances.
«  Modifying the RSLogix ladder.

Each of these activities is demonstrated using a simple example.

In addition to the things listed on page 9 you will need:

«  PAC Project Basic or PAC Project Professional. PAC Project Basic is free. Both versions are available on the
Opto 22 website, www.opto22.com.

o« ASNAP PAC-S series or -R series controller, or a SNAP PAC EB-series brain.

In this Chapter

Exchanging Values 49
Modifying PAC Control 49
Creating Scratchpad Assemblies with EtherNet/IP Configurator-........53
Modifying the RSLogix 5000 Ladder 59
Exchanging Data Online 61
More Ideas for Accessing Data 61

EXCHANGING VALUES

By doing the example exercises in this chapter, you will learn how to exchange several values between an
Opto 22 automation system and an Allen-Bradley PLC. Each system has a few variables that need to be
exchanged between each other. The example assumes that the control systems already exist and the
parameter sharing simply “marries”the two systems together.

MODIFYING PAC CONTROL

Your PAC Control strategy needs to be modified slightly to allow data to be read from and written to the
Allen-Bradley PLC. For small data-sharing applications, the modifications will take only a few minutes.
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Adding an OptoMMP Device

The first thing to do is add an I/0 unit to your PAC Control strategy.
1. If PAC Control isn't open, start it as follows:

«  InWindows, click the Windows Start button, and then click Opto 22 > PAC Control Basic 9.6 (or
PAC Control Pro 9.6).

2. Open your strategy in PAC Control.

4 PAC Control Basic - Cookies * - [Powerup] - O *

%File Edit Configure Chart Subroutine Compile Mode Tools View Window Help - 8 X

Blconts Lo o IR L AL

Cookies Lol | ~
[ IC5) Cookies

) Control Engines This chart starts the program and all other charts.

IC5) Subroutines Induded =
@ 3 Charts Start Program
= =) Variables
@ [C3) Mumeric Variables |
|5 String Variables
[C5) Painter Variables
[E5) Communication Hand
[E5) Mumeric Tables
[C5) String Tables T
[C5) Pointer Tables
£ 1/0 Units B Start the alarm monitoring
StartCharts | doughichip control, press
control, and oven/inspect
charts.

Wait until start flag is set
g | true (non-zero).

v
< >

(i)Shortcuts | 100% v

< > "|'|"|"-I\Char{/
SNt Prev (1o Powerup |

PAC Control: Ready Configure NUM

3. Double-click the I/0 Units folder to open the Configure I/0 Units dialog box.

4 Configure /0 Units X
Name Type Port Address Watch. Add...
Modify...
Delete
10 Points...
=3 > PID Loops...
Close Help Event/Reactions...

Click the Add button to open the Add I/0 Unit dialog box.
5. Add or select the following information, depending on the type of OptoMMP device you're using.
For S-series controllers:
— Name:Type a name for the device. In this exercise, our device is named “ioLocal.”
- Type: Select “Generic OptoMMP Device.”
— IP Address: Check the box for “Local (loopback).”
For R-series controllers or EB-series brains:

- Name: Type a name for the device. In this exercise, our device is named “ioLocal.”
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- Type: Select the part number for your SNAP PAC device.
— IP Address: Enter the IP address of your SNAP PAC device.
If you are using PAC Control Professional, leave the Secondary Address blank.

If you are using an S-series controller and PAC Control Basic, the completed dialog box should look like
this:

& Add /0 Unit X

Information

MName: | ioLocal |

Description: | |

Type

Type: | Generic OptoMMP Device At |

Addressing
IP Address: BTl B D

Ethernet Port: 2001

Communication from control

Enable communications from control engine

Timeout and disable communications after tries of second(s) each.

Cancel Help

Now, you're ready to modify the chart as described in the next section.

Modifying the Chart

In this section you will learn how to modify a strategy to exchange data. In the example, you will create a new
chart, but you can modify an existing chart the same way. The new chart will read and write shared values to
and from the scratchpad registers in the local I/0 unit.

The PAC Controller has 32-bit integer, 32-bit float, and string registers. 32-bit integers are synonymous to the
DINT data type. Opto 22 32-bit float data type is the same as the Logix REAL.

1. Before adding some code to the PAC Control strategy, create a couple of tables similar to the ones below
to show which scratchpad registers will hold what particular values.

32-bit Integer Scratchpads

0 i32PACBuffer_Tank_Ready
1 i32PACTank_Contents

2 dABFill_Tank

3 dABBottles_Filled

32-bit Float Scratchpads

Index Variable

0 f32PACGallons_In_Tank
1 rABGallons_Requested
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2. Using either an OptoScript block or an action block, create code to write PAC Control values to the
scratchpad. When the data is present on the scratchpad, it is available to be read by other applications
such as the Logix PLC.

Using an OptoScript block:

OptoS cript Code:

<7 met the integer scratchpad walue for reading by the A-B PLC
SetlolnitScratchPadInt 32Elemnent {iclocal 0, 132PACEBuffer_Tank Ready):
SetlolnitScratchPadInt 32Element (iolocal .1, 132PACTank Contents)

< =et the float scratchpad walue for reading by the A-B FPLC
SetlolnitScratchPadFloatElenent {iolocal 0, £ 32PACGallons In_Tank)

Using an action block to achieve the same thing:

Movve 32-bit Integers to Scratchpads
Comment (Single Lineg)

Set /0 Unit Scratch Pad Integer 32 Element

110 Unit ioLocal

Index 0

From i32PACBuffer_Tank_Ready
Put Status in dABBottles_Filled

Set /0 Unit Scratch Pad Integer 32 Element

110 Unit ioLocal

Index 1

From i32PACTank_Contents
Put Status in dABBottles_Filled

Movve Flost to Scratchpads
Comment (Single Lineg)

Set /0 Unit Scratch Pad Float Element

110 Unit ioLocal

Index 0

From f32PACGallons_In_Tank
Put Status in dABBottles_Filled

3. Once again using either an OptoScript block or an action block, this time create code that reads the
values the Allen-Bradley PLC writes to the scratchpads of the SNAP PAC controller.
The PAC Control environment reads the values emplaced by the A-B PLC and moves them into similarly
named variables.
Using an OptoScript block:

OptoScript Code:

<+ get the integer =cratchpad walue emplaced by the A-B FLC
GetIolUnitScratchPadInt32Element {iolocal. 2. dABFill_Tank:
GetIolnitScratchPadInt32Elenent (iolocal, 3. dAEBottles_Filled):

<+ get the float scratchpad walus emplaced by the A-E PLC
GetIolUnitScratchPadFloatElement {iolocal.l. rABGallons Reguested):

4 *

Using an action block sequence of commands to retrieve the A-B PLC scratchpad values:
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# Instructions - Data_Sharing - Read Scratchpads

Get 32-bit Integers from Scratchpads Add...
Comment (Single Line)

Get 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 2

Put Result in dABFill_Tank

Put Status in dABBottles_Filled

Get 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 3

Put Result in dABBottles_Filled
Put Status in dABBottles_Filled

Get Flosts from Flost Scratchpads
Comment (Single Line)

Get 1/0 Unit Scratch Pad Float Element

10 Unit ioLocal

Index 1

Put Result in rABGallons_Requested
Put Status in dABBottles_Filled

[ Cloze ] [ Help ] [

See the next section for more scratchpad read and right commands.

Scratchpad Read and Write Commands
Here is a complete list of the PAC Control scratchpad read and write commands.

Scratchpad Read Commands:

«  Getl/O Unit Scratch Pad Float Element

«  Get /O Unit Scratch Pad Float Table

«  Get1/O Unit Scratch Pad Integer 32 Element
«  Getl/O Unit Scratch Pad Integer 32 Table

«  Get /0 Unit Scratch Pad String Element

«  Get /0 Unit Scratch Pad String Table

Scratchpad Write Commands:

«  Setl/O Unit Scratch Pad Float Element

«  Setl/O Unit Scratch Pad Float Table

«  Setl/O Unit Scratch Pad Integer 32 Element
«  Setl/O Unit Scratch Pad Integer 32 Table

«  Setl/O Unit Scratch Pad String Element

«  Setl/O Unit Scratch Pad String Table

CREATING SCRATCHPAD ASSEMBLIES WITH ETHERNET/IP CONFIGURATOR

For this section you will need to use EtherNet/IP Configurator to create assemblies to exchange between the
PAC controller and the Allen-Bradley PLC.
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Creating an Assembly to Send Data to the PLC

1. If EtherNet/IP Configurator isn't open, start it as follows:

«  InWindows 7, click the Windows Start button, and then click All Programs > Opto 22 > PAC Project 9.6 >
Tools > EtherNet-IP Configurator.

«  InWindows 10, click the Windows Start button, and then click Opto 22 > EtherNet-IP Configurator.
Starting EtherNet/IP Configurator immediately creates a new configuration.

# Untitled - EtherNet/IP Configurator,
File Edit Tools Wiew Help

O=HE ?

= Add new device... - -
2B Lnname: e Configure 1/0 Modules & Paints | Configure PID Loops] Canfigure Assemblies] Werify ]

Discovered Devices

Modules and Paints | Type | Feature / ¢ &

Add... |
[k
ey |

Expand All
Collapse Al
1 v

Ready MM

Double-click the Unnamed_Device in the device tree to open the Madify Device Definition dialog box.
3. Select the Device Type that matches your controller.
Enter the IP address of the SNAP PAC controller in the IP Address field.

The example uses a SNAP-PAC-S2 with the IP address of 10.154.92.57, but you can use any R-series or
S-series controller, or EB-series brain.

Modify Device Definition

Device Name: [SNAP_PAC_52
Description: |The PAL Controller
Device Type: |smp—mc—51;’sz j
IP &ddress: 10.154.92.57
Part: 2001
Temperature; & (®
‘watchdog: = (o
()8 | Cancel |

5. Click OKto close the dialog box, then click the Configure Assemblies tab.

The tab opens assembly instance 100, which you will use to send the appropriate scratchpad data to the
Allen-Bradley PLC.
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# Untitled* - EtherNet/IP Configurator

File Edit Tools Wiew Help

O=H ?
= Add new device... - -
+- SMAP_PAC_S52 Configure 1/0 Modules & Paints | Configure PID Loops — Configure Assemblies l\u"erify ]

Discovered Devices
Aszzembly Ingtance: 100

| 100101 [ 102 [ 103 [ 104 [ 105 [ 105 [ 107 [ 108 [ 109 | 110 [ 111 [ 112 [ 113 [ 114 [ 115
Drescription:

Aszzembly Members:
#t | DINT [ Bit | Size | Class Instance [

Add

i

Ready MM

6. Begin populating assembly instance 100 by clicking the Add button to open the Add Assembly Member

dialog box.

Add Assembly Member le

Drescription:

Instance Information: Altribute:

& |nput Point
Dizcrete Dutput Point " Paint Name
Analog Input Paint
Analog Dutput Point
Load Cell Input

FeatureSelect
| FeatureEnable

J Featurelfalue

ClearFeaturelfalue
Scratchpad DINT OnLatch
Scratchpad REAL : OffLatch
Seratchpad STRING 5 s B =
Fulse And TPO Generator M ’—_|
Famp Controller Paint: o h

FID Loop Controller
Communication W atchdog
Pad

(] 8 | Cancel |

7. Select the following items:

- Class: ScratchpadDINT (Notice that the available fields change.)
— Instance Information

Start Element: 0

#of Elements: 1

- Attribute: Value

Description: Add a comment such as “Location for i32PACBuffer_Tank Ready”to indicate which

value this scratchpad location will transfer. The example is the scratchpad element for the PAC
Control variable i32PACBuffer_Tank Ready.
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Add Assembly Member

X

D escription:
|Location for 1I32PACBuffer_T ank_Ready

Class: Inztance Information: Attribute:
Discrete Input Point ale |
Dizcrete Output Paint StartElement: |0

Analog Input Point
Analog Output Paoint # of El w1
Load Cell InEut of Elements: l—

Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Ramp Controller

FID Loop Controller
Communication W atchdog
Pad

Ok, | Cancel |

8. Inthe same manner, add ScratchpadDINT element #2 for “i32PACGallons_In_Tank.”

Add Assembly Member, [$_<|

Dezcription:

|Locali0n for i32PACGEalons_In_Tank

Class: Inztance Infarmation: Attribute:
Digcrete Input Paint

Dizcrete Output Paint StartElement; |0

Analog Input Paint

Analog Output Paint 1 of EI ts: 1

Load Cel Input ol Bements:

Scratchpad REAL

Scratchpad STRING
Pulze &nd TPO Generator
Rarmp Cantroller

FID Loop Controller
Communication watchdog
Pad

Ok | Cancel

9. Toadd the float variable, click again and select the following items in the Add Assembly Member dialog

box:

Class: ScratchpadREAL
- Start Element: 0

Description: Location for f32PACGallons_In_Tank
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Add Assembly Member, El

D escription:
|Location for F32PACGallons_In_Tank

Class: Inztance Information: Attribute:

Discrete Input Point ale |
Dizcrete Output Paint StartElement: |0

Analog Input Point

Analog Output Point # of Elements: |1

Load Cell Input )

Scratchpad DINT

Scratchpad STRING
Pulze And TPO Generator
Ramp Controller

FID Loop Controller
Communication W atchdog
Pad

Ok, | Cancel

10. Click OK.

Your completed assembly instance 100 should look similar to this:

# Untitled* - EtherNet/IP Configurator

File Edit Tools Wiew Help

O=H ?
= Add new device... - -
+- SMAP_PAC_S52 Configure 1/0 Modules & Paints | Configure PID Loops — Configure Assemblies l\u"erify ]

Discovered Devices
Aszzembly Ingtance: 100

101 | 102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 [ 111 | 112 | 113 | 114 | 115
Drescription:

|Data from PAC Control to the A-B PLC
Aszzembly Members:

# | DINT | Bit | Size | Class Instance | Attribute | Description
1] 1] 1] 32 Scratchpad DINT  Element: 0 Value Location for i32PACBuffer_Tank_Ready
1 1 1] 32 Scratchpad DINT  Element: 1 Walue Location for i32PACG allons_In_Tank

2 2 0 32 Scratchpad REAL  Element: 0 Walue Location for f32PACG allons_|n_Tank Delete

Modify

|

o ge

Ready

Creating an Assembly to Accept Data from the PLC

This section describes how to create assembly instance 101, which will be used to accept data from the
Allen-Bradley PLC. This is similar to creating assembly instance 100.

1. Follow the directions in the previous section for creating assembly instance 100, except note the minor
differences for the Element values.

When completed, assembly 101 should look similar to this:

I04AB User's Guide 57



CREATING SCRATCHPAD ASSEMBLIES WITH ETHERNET/IP CONFIGURATOR

2,

3.

# Untitled* - EtherNet/IP Configurator
File Edit Tools Yew Help

D= %
—|- Add new device... - -
+- SMAP_PAC_S2 Configure |40 Modules & Points | Configure PID Loops  Configure Assemblies l\-’erif}l ]

Discovered Devices
Azgembly Ingtance; 101

102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 111 | 112 | 113 | 114 | 115

Descriphion:

|Drata from 4B PLC to PAC Cantrol
Aszembly Members:

# | oNT | Bit | Size | Class Instance Atribute
0 0 1] 32 Scratchpad DINT - Element: 2 Yalue Add
1 1 ] 32 Scratchpad DIMT - Element: 3 Walue
2 2 1] 32 Scratchpad REAL  Element: 1 “alue Delete
Modify
Ready LM

To download the configuration to the PAC controller, choose Tools > Download Configuration to Opto 22
Device.

The following dialog box appears.

# Download Configuration to Opto 22 Device

Mame Drescription Port Address List Download
10.154.92.57
Clear Settings

Cloze

Timeout [meec]:

| B 10000

|

Click the Download button.

The following status information should appear showing that the configuration has been successfully
saved to flash.

# Download Configuration to Opto 22 Device rz|
Mame | Description | Fart Address List | D ownload |
SMAP_PAC 52 The PAC Controller 200 10.154.92.57

Clear Settings
Cloze

Timeout [mzec]:

< | > 10000 << Details

Configuring Device: 10.154.92.57
16 of 16 Assembly Instances successfully configured.
Configuration saved to flash

Device: 10.154.92.57 Complete
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4. Ifyou haven't already done so, choose File > Save As to give your configuration project a name and to
save it for later use.

Once you have created assemblies 100 and 107 using EtherNet/IP Configurator, the next step is to use RSLogix
5000 to add some code to exchange data with the Assembly Instances you just created.

MODIFYING THE RSLOGIX 5000 LADDER

In this section you will do the final step of integrating the two systems together by adding functionality to the
PLC's ladder. The instructions are for a ControlLogix PLC (1756-L61).

In previous sections you modified the scratchpad read and write values in the PAC Control strategy, and you
used EtherNet/IP Configurator to configure the PAC Controller to expose the scratchpads with Assembly
Instances 100 and 101.

In the following exercise you will add the interface to RSLogix 5000.
1. Add a Generic Ethernet Module to the Logix PLC's EtherNet/IP module using the following settings.
- Name: PAC
—  Comm Format: Data - DINT
— 1P Address: Use the address of your PAC Controller
- Connection Parameters

Assembly

Instance Size
Input 100 3
Output 101 3
Configuration 254 0

The Input and Output Assembly Instance information is based on the Assembly Instances created in the
EtherNet/IP Configurator software.
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Leave the Configuration Assembly Instance to 254 and the size to 0 because the configuration
assembly is not used. These settings tell RSLogix 5000 to ignore it.

New Module [$__<|
Type: ETHERMET-MODULE Generic Ethernet Madule
“endor: Allen-Bradley
Parent: EIF
Marme: FAC Connection Parameters
Azzembly )
Deszcription; Instance: Size:

IrpLt 100 3 J;I [32-hit)

Dutput: 101 3 = 26

Caomm Farmat: |Data -DINT ﬂ . - [o5a 0 = 0
PN rr— Configuration: J;I [B-hit]

& |P Address: | 10 129 . 45 . 1N

™ Host Mame: |

[v Open Module Froperties 0K | Cancel | Help

2. (lick OKto open the Module Properties dialog box.
3. Clickon the Connection tab and set the RPI to 500 milliseconds for demonstrating the data exchange.

M Module Properties: EIP (ETHERMET-MODULE 1.1)

General  Connection” l Module Info]

Requested Packet Interval [RPI): 500.03: ms  [1.0- 3200.0 ms]
[ Inhibit Module

[~ Major Fault On Contraller IF Connection Fails While in Bun Mode

Module Fault

Status: Offline ()8 | Cancel | Apply | Help |

4. You're almost done. Now you just need to add a few CPS commands to copy the Generic Ethernet
Module's data to and from local variables of the ladder.

Here's a screen shot of the complete CPS instructions in the ladder.
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RSLogix 5000 - Bottling [1756-L61]* - [MainProgram - MainRoutine]

Bf Fle Edit ¥iew Search Llogic Communications Tools Window Help —| &%
| dlmle] ol o] #lalal[F MEl @lal
Offline 0. FRUN _I_ T Path: |AB_ETH\P-1\10192 54,7648 ackplanet0 ;Iﬁ
Mo Forces b, :: E.ET 4’
Mo Edits &. it} ﬂ | | | | | | ‘ ‘ ﬂ
| [ Y e e T
== || el lslele]
= £ MainTask.
= I:i; MainProgram Move Yalues from the PACT Module Array to PLC Vaniables A
Program Tags Fram the PAC
% MainRauting PAC Conlrco;\sfamable ant;gl\al -
[ Unscheduled Programs Sk Cony i Sunch Cone Fil Sunch Conw Fi
Motion G 0 pnchronous Copy File 1 Synchionous Copy File 1 Spnchronous Copy File —
a DD ‘5“ ’°“"sd : Source PAC Datal0] Source PACI Datal1] Source PAC Data[2)
N ope _XES Dest i32PACBulfer_Tank_Ready Dest i32PACTank_Contents Dest FI2PACGallons_In_Tank
(23 Add-On Instructions Length 1 Length 1 Lenath 1
£ Data Types
Eﬂ User-Defined
+ L Shings Move Yalues from PLC Yariables to the PAC:D Array
Eﬂ Add-On-Defined Ps CPs ors
: % :!Ir::j:-n;:ﬁned 1 Spnchronous Copy L Swnchionous Copy File I Swnchronous Copy File [I—
& Source dABFill_Tank Source dbBBottes_Filed Source BGallons_Requested 1
Trends Dest  PAC:0Datall] Dest PAC:0.Data[1] Dest PAC:0.Datal2]
3 1o Configuration Length 1 Length 1 Length 1
=183 1756 Backplane, 1756-417
f [0] 1756-L1 Bottling
= B [1] 1756-EMET/R EIP
) Z Ethernet 2 2
< | B MainRoutine J
4 L ' 4 »
Activate the Routine: MainPragram - MainRoutine(Ladder Diagram) Rung?? of 77 APP VER

Now the ladder is ready to be downloaded.

EXCHANGING DATA ONLINE

When online, RSLogix will populate value fields something like this:

Logix 5000 - Bottling [1756-L61] - [Controller. Tags - Bottling(controller)]

File Edit WYiew Search Logic Communications Tools Window Help - | &8 x
Bl=|@| &l &|®|e| o] = & [ v @l
Rem Run 0. I RUN [ Path: [AB_ETHIP-1%10.176.52 5448 ackplane\ & kS
Mo Forces b :: Ok @
: BAT
NoEdis EY S K1 Wl =0 = T B RO RO P A
Bl i £ ST ST W
= £ Controller Botting ~ || || Secope: | §aBotting v| _ Show. | MESSAGE
(el e Name & | Value | Force Mask «| sSiyle Data Type +
3 Controller Fault Handler 5
(3 Power-Lp Handier [-daBBottles_Filed 324003 | Decimal |DINT
=25 Tasks H-d&BFill_T ank —1; _Decinal DINT
=58 MainTask [32PACGallons_In_T ank 12536.0 Float REAL
+-C8 MainProgram [ |#32PACBuffer_T ank_Ready 1 Decimal DINT
(33 Unscheduled Programs H32PALT ark_Contents 14| |Decimal DINT
i et [ |EPace | | ABETHEF
tngrouped fixes | ABGalons_Requested 150000.0 Floal REAL
23 add-on Instructions -
-5 Data Types
L User-Defined
+ Cﬂ, Strings B
L add-On-Defined
+- L Predefined
+- g Module-Defined
23 Trends
=423 1f0 Configuration v L]
£ | > =
= = < [» [\ Manitor Tags ) Edit Tags / ] [ [
Ready
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As shown here, you can create a watch window in PAC Control to see the exchanged values.

#PAC Control Basic - [watch] (=3
&d" File Edit Control Engine Debug  Chart  Subroutine Mode Tools  Wiew Wakch  ‘Window  Help Lo I

CR 0
x| | Hame Type TVAL
® I Control Engines ~ dABBottles Filled Integer 32 Variable 324003
[ Subroutines Include dABFill Tank Integer 32 Variable o
5 © Charts
= ?O Data_Sharing i32PACBuffer Tan... Integer 32 Variable 1
=+ ?Opuwerup 132PACTank Contents Integer 32 Variable 14
= ) Variables _— rABGallons Reque... Float Variable 150000
= I Numeric Variab -
(12 dABBottles.
121 dABFill_Tan

Iz
34 £32PACGall
(8] i32PACBuff
&l 32PACTani
12 39Pow Mic ¥

< | ? K3 |

L4 >
db Mext 4 Prev & Pawerup 8 watch

IPAC Control: Ready INFO  wWaARNING [EGTelW Debug MM
—
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Once the data is exposed into the PAC Controller's scratchpads, the following methods are available to
access it.

OptoOPCServer

The Opto 22 OptoOPCServer is a high-performance, multithreaded OPC DA 2.0 complaint data server. Using
SCADAs and OPC Clients to access data, the scratchpad registers created in the example exercise are
accessible using the OptoOPCServer. The following table translates which variables belong to the appropriate
tags:

Shared Variable OPC Item ID

i32PACBuffer_Tank_Ready  [mmio|ip|tcp:10.192.54.75:2001]sp_integer[0]

i32PACTank_Contents [mmiolip|tcp:10.192.54.75:2001]sp_integer[1]
dABFill_Tank [mmiolip|tcp:10.192.54.75:2001]sp_integer[2]
dABBottles_Filled [mmiolip|tcp:10.192.54.75:2001]sp_integer[3]
f32PACGallons_In_Tank [mmiolip|tcp:10.192.54.75:2001]sp_float[0]
rABGallons_Requested [mmiolip|tcp:10.192.54.75:2001]sp_float[1]
PAC Display

Once the data is available in the scratchpads, they may also be displayed in PAC Display, Opto 22's HMI
package. To access the scratchpads of the PAC controller, download and install both PAC Display Basic and PAC
Control Basic, both free software packages available on the Opto 22 website, www.Opto22.com.

Using PAC Control Basic, do the following:
1. Create a new strategy (File > New Strategy).
2. Right-click the I/0 units folder and choose Add to open the Add I/O Unit dialog box.
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3.

4.

CHAPTER 6: CONNECTING PAC CONTROL AND ALLEN-BRADLEY SYSTEMS

Provide a name, and select the Type as follows:

—  Fora SNAP-PAC-S series controller, select the Generic OptoMMP Device.

—  Fora SNAP-PAC-RT or SNAP-PAC-EBT1, select SNAP-PAC-R1.
—  Fora SNAP-PAC-R2 or SNAP-PAC-EB2, select SNAP-PAC-R2.

#1 Add 1/0 Unit X

Infarmation

Hame: | My Shategy |

Descrption: | |

Type
Tupe: | Genenc OptotdbP Device - |

Addreszing

1P Addess: [z 0 0 1] i
Ethernet Port: 200

Communication from contral engine

Enable communications from control engine

Timeout and dizable communications after tries of zecond(s) each.

QK H Cancel ” Help ]

Save and close your strategy.

Use your new strategy as the tag database into PAC Display.

Using a Free OptoMMP Toolkit

If you wish to use a custom PC application to access the data, use an OptoMMP Communication Toolkit to

access the scratchpad registers. The free kits are available on the Opto 22 website:

For NET: PAC-DEV-OPTOMMP-DOTNET
For C++: PAC-DEV-OPTOMMP-CPLUS
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7: Using EtherNet/IP
Configurator

This chapter expands on the information in the previous chapters about EtherNet/IP Configurator and
includes additional topics not covered there.

In this Chapter

Importing an Existing Configuration 65
Uploading a Configuration from an Opto 22 DeVICe ......ecreerssenns 66
Adding a Device Manually 68
Modifying a Device 69
Changing a Device’s IP Address 69
Adding and Deleting Assembly Elements 70
Moving Assembly Members 73
Viewing a Configuration Report 74
Configuring PID Loops 75
Inspecting and Tuning PID Loops 80
Using I/0 Point Features 91
Referencing I/0 Points on SNAP PAC Racks 93

IMPORTING AN EXISTING CONFIGURATION

If you have an I/0 configuration created in EtherNet/IP Configurator, you can import its otg (Opto Tag
Database) file and from it create a new configuration.

NOTE: You can also use an otg file created in Opto 22's PAC Control or PAC Manager. For more information, see the
user's quides for those products, form 1700 (for PAC Control) and form 1704 (for PAC Manager).

1. Inthe EtherNet/IP Configurator main window, click the Open button [ | or choose File > Open to open
the Tag Database dialog box.
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2,

Open Tag Database

Lok i |E} Configuration Files j L= ¥ E2-

File hame: |D pto_22 Config.otg

ﬂ Cancel

Files of type: |E|ptc| Tag Database Files [“.otg)

Locate the configuration (otg) file and click Open.

‘. EtherNet/IP Configurator - Opto_22_Config™
File Edit Tools View Help

O %

= Add new device...
¥ SMAP _PAC_FEL
+-SMAP_PAC_RZ

Configure 120 Madules & Points | Configure PID Luups] Configure Assembliesl Werify ]

+-SMAP_PAC_S1

i ) Modules and Points | Type ‘ Features / Subty... | Units ‘ W
Discovered Devices # [ [00] SNAPADCSD: 25 - 28VDC Digital [rput

+ gl [01]5MAP-ODCSSRC: 5-B0YDC Souce  Digital Qutput

+ ﬁ [02] SHAP-ADN-27 Analag Dutput

+ - [03] SNAP-AICTD Analog Input Madify

+ - [04] SNAP-AlY Analog Input
Expand Al
Collapse All

Feeady

UPLOADING A CONFIGURATION FROM AN OPTO 22 DEVICE

If there is an existing configuration that you want to use loaded on an Opto 22 device, you can upload it to
EtherNet/IP Configurator, and then modify it (if necessary) and reuse it on another device.

NOTE: When uploading EtherNet/IP configurations from PAC devices, the following information is not stored on the

/0 unit and thus is lost during the upload.

«  PIDnames
PID descriptions

«  Point descriptions

«  4-channel digital module types
Assembly Instance descriptions
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To upload a configuration:

1.

3.

In the device tree, select the Opto 22 device with the configuration you want to load.

‘r. EtherNet/IP. Configurator - Opt

_l File Edit Tools Yiew Help
(= = s

- Add new device...
+

Selectan Opto 22 Bty

device + SHAP_PAC_S1
- Discovered Devices
00-A0-30-00-90-F5

Choose Tools > Upload Configuration from Opto 22 Device.
The following dialog box appears.

EtherMet/IP Configurator

P | 1j0Paint and Assembly configuration data will be imported From device SMAP_PaC_RZ.
\{,) This operation wil averwrite existing configuration data. Are you sure that you want to procesd?

Click Yes to upload the configuration data. This action overwrites the device’s existing configuration data
for any module position that is the same as the new configuration data.

DOWNLOADING A CONFIGURATION

1.

To save the configuration, choose File > Save As, browse to an appropriate directory, name the file (for
example, Opto_lO), and then click Save.

Click the Verify tab and then click the Download button. (Or you can choose Tools > Download
Configuration to Opto 22 Device.)

In the Download Configuration dialog box, select the device’s IP address, and then click Download.

Download Configuration to Opto 22 Device

Download

Clear Seftings
Cloze

Name | D escription | Port Address List
Opto_22_IRID 200 152.168.0.26

Timeout [meec]:

| s [1ooon

|

4. When the configuration has been downloaded successfully, click Close.
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ADDING A DEVICE MANUALLY

68

In addition to being able to add a discovered device, you can also add a device manually. To add a discovered
device, see "Adding an Opto 22 Device”on page 10.

1.

2.

In the device tree, double-click Add new device.

Untitled - EtherNet/IP Configu
File Edit Tools Wiew Help
DEE %
=B Add héﬁ'de'vi'ci:.'k
=+ Unnamed_Diesick
Discovered Devices

In the New Device Definition dialog box, at minimum enter the Device Name, select the Device Type, and
enter the IP address for the device.

New Device Definition

Device Name: |Elpto_22_ID_B

Drescription: |

Device Type: |SNAP-PAC-EEZ ~
IP Address:  |10.172.44.115

Part: 2001

Temperature: @ Fahrenheit ¢ Celsiuz

Wwatchdoo: * No  ‘Yes

0] | Cancel |

Device Name. Enter a name for the remote I/0. The name must start with a letter and may contain
letters, numbers, and underscores. (Spaces are converted to underscores.)

Device Type. Choose the part number of the Opto 22 device from the drop-down list.
IP Address. Enter the IP address of the device.

NOTE: Changing the IP address in this dialog box does not change the IP address on the device. If you want to
change the IP address on the device, see “Changing a Device's IP Address” on page 69.

Port. The default Ethernet port number is 2001 for communication with the Opto 22 device. If you have
changed this port for security purposes, also change it here. (See the device's user guide for details.)

Temperature. Choose whether temperatures will be handled in Fahrenheit or Celsius.

Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you select
Yes, a new field appears; enter the Watchdog timeout value (in seconds). The default timeout is 0.5
seconds.

NOTE: If you want to enable Watchdog on a point, make sure to enable it here at the device level as well.

Click OK.
The new device appears in the device tree.
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MODIFYING A DEVICE

Do the following steps to change a device's information.

CHAPTER 7: USING ETHERNET/IP CONFIGURATOR

F System IV* - EtherNet/IP Config

File Edit Tools Yiew Help
= ?
- Add new device...

+- Unnamed_Device
BRorie TR

Discovered Devices

1. Inthe device tree, double-click the device to open the Modify Device Information dialog box.
2. See "Adding an Opto 22 Device”on page 10 for tips on how to use this dialog box.

Modify Device Definition

X

Device Mame: |[1]
Description: |
Device Type: |SNAP—P.°,C—EBZ j
IP Address: |TU.U.U-2
Port: 200
Temperature: % Fahrenheit ¢ Celsius
‘watchdog: * Mo © Yes
Ok | Cancel |

NOTE: Changing the IP address in this dialog box does not change the IP address on the device. If you want to
change the IP address on the device, see “Changing a Device’s IP Address” (below).

3. Click OKto confirm the changes.

CHANGING A DEVICE'S IP ADDRESS

1. Right-click the device in the device tree and choose Change IP Settings to open the Change IP Settings
dialog box.

Change IP Settings for 10.192.54.115 [gl

IP Addresz: M. o .0 .0

Subnet Mask:

| 255 . 255 0132 . 0

Gatewa}l.&ddress:| o . o0 . o0 .0

DNSAddesss | O . 0 . 0 . O

=]

Cancel |
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2. Enterthe IP Address and the Subnet Mask for the device. If it will be talking to a device on another
subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave the gateway
address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 and the Host Name field blank.

NOTE: Make sure the EB1 is on the same subnet as the computer and the PLC.

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on, must
have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware
failures. Ifyou don't know which IP addresses are safe to use, check with your system administrator.

3.  When the IP address, subnet mask, and other fields are correct, click OK.

ADDING AND DELETING ASSEMBLY ELEMENTS
1. Click the Configure Assemblies tab, and then click the Add button to open the Add/Modify dialog box.

Add Assembly Member

Description:

X

Dizcrete Input Foint
Digcrete Output Point
Ainalog Input Point
Analog Output Point

Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulse &hd TPO Generator
Flamp Contraller

FID Loop Controller
Communication W atchdog
Pad

o]

Cancel |

Instance |nformation:

" Paint Mame

|
Module: |0 -

Fairt: a -

Attribute:

FeatureSelect
FeatureEnable
Featurelalues
ClearFeaturetalue
OrLatch

OffLatch

2. Selecta class from the list on the left.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the CIP classes,
all of which are available through explicit messaging. For information on the CIP classes and attributes,

see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.

3. Under Instance Information, select a point that you have configured. Otherwise, you can assign an
assembly member to a specific module and point based on their position on the rack. (See page 93 for
module and point addressing.)
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Add Assembly Member E|
Description:
Class: Inztance Information: Attribute:

ke [nput Paint

Dizcrete Output Point " Point Mame FeatureSelect
Ainalog Input Point FeatureE nable
Ainalog Output Point |Phgt0_Sensg|' {Mad:00 Pt:Dﬂ Feature'/alue
Load Cell Input R i ad: b0 - ClearFeaturet alue
Sciatchpad DINT — OnlLatch
Scratchpad REAL ) OffLatch
Scratchpad STRING e =

Pulze And TPO Generator ; ,—_|
Famp Contraller Point:

PID Loop Controller

Communication ‘W atchdog

Pad

Ok, | Cancel

Under Attribute, select an item in the list.

The attribute list allows you to define what information from each point you want to have passed in the
implicit message. In addition to value readings, you can get other data, such as the minimum or
maximum value that the point has ever reached. This is a great way to attain an alarm level without
having to write logic in your RSLogix program that stores the high value.

Click OK and follow any directions that appear for the class.
For example, the Fill Module dialog box appears for Discrete Input Point and Analog Input Point.

Fill Module

“would pou like to fill the rezt of the module with the same type of point?

* Yezs Mo

How many pointz does this module have? |4 -

Click OK.
Continue to add elements as necessary.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add padding.

To add a pad, click the Add button to open the Add/Modify dialog box.
Under Class, select Pad, enter size of the pad (for example, 28), and click OK.
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Add Assembly Member

X

Description:

Class: Inztance Information: Attribute:
Digcrete Input Point

Dizcrete Output Paint Size In Bits: |28

Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Ramp Controller

FID Loop Controller

Communication Watchdoi
Ok, | Cancel |

The pad appears as the last member of element 0 to complete the 32-bit word.

10. To save the configuration, choose File > Save As, browse to an appropriate directory, name the file (for

11.

12.

13.

example, Opto_lO), and then click Save.

Click the Verify tab and then click the Download button. (Or you can choose Tools > Download
Configuration to Opto 22 Device.)

In the Download Configuration dialog box, select the device's IP address, and then click Download.

NOTE: Make sure that the SNAP 1/O is properly configured with a SNAP PAC EB-series or R-series brain loaded
with firmware R8.3a or newer, and that the proper I/O modules are installed. Otherwise, errors will occur.

The configuration is permanently stored in the device.

Download Configuration to Opto 22 Device [5_<|

Downlaad |
Clear Settings

Cloze

MName | D ezcription | Port Address List
Opto_22 |RID 200 1 ]

Timeout [meec]:

| s [toooo

|

When the configuration has downloaded successfully, click Close.
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8 Download Configuration to Opto 22 Device

Name | D escription | Port Address List | |

o'i-{-'ﬁ'l'é'ad""‘gl
Opto_22_IRID 200 192.168.0.26

Clear Settings
Closet

Timeout [mzec):

< | = 10000 << Detailz

Configunng Device: 192.168.0.260
9 points succersiully configured.
1 of 1 PID Loops successfully configured.
16 of 16 Agzembly Instances successfully configured.
Configuration saved to flagh
Device: 192.168.0.26 Complete

MOVING ASSEMBLY MEMBERS

The Up and Down arrows allow you to move assembly members up and down in the assembly. For example,
if a pad is in the wrong place, some of the assembly members will be highlighted in yellow as shown here:

Canfigure 1/0 Modules & F'c-ints] Canfigure PID Loops  Configure Assemblies ]Verify ]

Azzembly Instance: 101
102 1103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 [ 112 | 113 | 114 | 115

Description:

Azzembly Members:

# | DINT | Bit | Size | Class | Instance | Attiibute

0 0 0 1 Dizcretel nputPaoint diSwitch_ DO Maod:00 PLO0 Value

1 0 1 1 Dizcretel nputPoint diSwitch_D1 Mod:00 Pr0l Value

2 0 2 1 Dizcretel nputPoint diButton_Ct2 Mod00 PLOZ2  Walue

3 0 3 1 Dizcretel nputPaint difutton_Ct3 Mod:00 PEO3  Yalue

4 0 4 32 AnaloglnputPaoint alPID_Input Mod:03 PEOD  alue Madify

5 il 4 32 AnaloglhputPaint aifoom_Temp Mod:03 Pt.. ralue

E 2 4 28 Pad = Up and Down

T arrows

< !
Instance Size: 3DINT 2 [125 Max)

|

To move the pad, select it and click the appropriate arrow to move the pad into its proper place.
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Agzembly Ingtance: 101

Configure 140 Modules & Points | Configure PID Loops  Configure Assemblies ]Verify ]

Description:

102 | 103 | 104 [ 105 | 106 | 107 | 108 | 109 | 110 | 111

2 13| 114115

Azzembly Members:
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B AssemblyConfigReport.txi - Notepad

# | oiNT | Bit | Siee | Class Instance Attribute
0 0 0 1 DigcretelnputPaint diSwitch_D0 Mod:00 PEOD Walue

1 0 1 1 DigcretelnputPoint diSwitch_D1 Mod:00 PEOT Walue
2 i] 2 1 DigcretelnputPoint diButton_CtZ Mod:00 P02 Walue

3 0 3 1 DigcretelnputPaint diButtor Ct3 Mod:00 PEO3 Walue
4 [0 [4 (28 [Pad

] 1 1] 32 AnaloglnputPoint aPID_lnput Mod:03 PEOD Malue
5 2 i] a2 AnalaglhputPaint aiRoom_Temp Mod03 Pt..  Malue

The input assembly instance is now once again formatted properly with 32-bit words.

Delete

Modify

o e

Available in the Tools menu are reports that provide a snapshot view of the configured assemblies and 1/0.

An Assembly Configuration Report shows all of the entries contained in the current assembly instance,
including the element number, bit size, and description. It also indicates any errors and whether or not the
assembly is configured properly for download. It is helpful to check for errors in this report before you
download the configuration to the device.

File Edt Format Wisw Help
pevice: SNAP_PAC_ R Type: SMAP-PAC-RL IP Address: 10.182.64.115 -~
ASSEMBELY VERIFICATION
Total Assembly Members: 7 (4096 Max)
Total Assemhly size: 2 DINTS (125 Max)
A1l assembly Instances are configured properly! Ok to download this assembly.
ASSEMELY DETAILS
Assembly Instance 100, size: 2 DINTS
# DINT  BIT SIZE  CLASS INSTANCE ATTRIBUTE
0 0 0 1 DiscreteoutputPoint alarm wmod:01  Pt:00 value
1 0 1 1 DiscretecutputPoint Freezer_Door_Status Mod:01 Pt:0lvalue
2 0 2 1 DiscretecutputPoint Inside_Light mMod:01 pPt:02  value
3 0 3 1 DiscretecutputrPoint outside_Light Mod:01 Pr:03 value
4 o] 4 28
5 1 0 16 analogoutputPoint Fuel_pisplay mMod:oz pPr:00  wvalue 4
] 1 18 18 Pad
b

|04AB User's Guide

The I/0 Modules and Points Configuration Report lists the modules and points configured for the selected
device.




CHAPTER 7: USING ETHERNET/IP CONFIGURATOR

I I0ConfigReport.txt - Notepad E”E‘El
File Edt Format View Help
Device: SMAP_PAC R Type: SNAP-PAC-RZ IP address: 10.129.45.115 A

[00] pigital Input (white) SwnAP-IDCSD
[00? Emergency_switch

[01] Digital output (Red)  SNAP-ODCSSRC
[00?[1 Alarm

[01] Freezer_Door_Status
[02] Inside_Light
[03] outside_Light

[02] analog output (Green) SNAP-AOV-27
[00] POiNt2_0_SNAP_PAC_R
[01] Poinmt2_L_SNAP_PAC_R

[03] Analog Input (Blue) SHAP-ATICTD
[00] POiNt3_0_SNAP_PAC_R
[01] Point3_1_sNAP_PAC_R

[04] analog Input (Blue) SHNAP-ATV
[00] POINt4_0_SNAP_PAC R
[01] Pointd4_1_sMAP_PAC_R

To view a configuration report:
1. Inthe device tree, select an Opto 22 device.

‘z. EtherNetfIP Configurator - Opt

Flle Edit Tools ‘iew Help

O ?

- Add new device...

Selectan o
OptO 22 device +- SHap_Packh
+- SMAP_PAC_S1
-|- Discovered Devices
00-40-30-00-90-F3

2. From the Tools menu, choose either Assembly Configuration Report or I/0O Modules and Points
Configuration Report.

A text file opens showing the configuration report.

CONFIGURING PID LOOPS

PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value (the
setpoint) and keep the input very close to that value by controlling an output. For example, consider
temperature control, where the input is a measurement of ambient temperature, the setpoint is the desired
temperature, and the output is a heater. The PID for this system will use a mathematical formula that controls
the output to maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for
changes in load, such as the influx of cold air. In this example, a temperature sensor (analog input), a
thermostat (analog input), and a heater control (analog output) are components of one system, controlled by
a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and the physical
qualities of systems suitable for PID control differ greatly. This guide includes only basic information for
configuring PIDs.

SNAP PAC 1/0 units support 96 PID loops. PIDs can control isolated systems or be part of cascaded systems
where one loop controls the setpoints or input variables of others.

Adding a PID Loop

The PID operates at the I/0 unit, independently of the controller. Once configured and downloaded to the
brain, a PID operates until the I/0 unit loses power. Remember that changes are not written to the I/0 unit
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until the configuration is downloaded to the Opto 22 device. Each PID loop must be individually configured
and tuned.

Tuning steps are described in “Inspecting and Tuning PID Loops”on page 80. For additional information, see
form 1641, Optolutorial: SNAP PACPID.

1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops tab.

Configure PID Loops tab
= 96pidloops - EtherNet/IP Configurator
gpto 2 File Edit Tools View Help
evice ~
L=y = ?
-“dd new device... - |
+ Configure 1/0 Modules & Points - Canfigure PID Loops l Configure Assemblies] Werify ]
+- i0SEHDAPIDSE -
Lowest - Discovered Devices # | Mame | Input [ Setpoi &
00-A0-30-01-30-99 00 pidS5Yout 0000 PLC FLC
unused Ft—Not Used
02 MotUsed
number 03 MotUsed 4
04 Mot Used
05 Mot Used 4
06 MotUsed
07 MotUsed El
08 MotUsed L]
Ready MM

2. Double-click the lowest unused number to open the Add PID Loop dialog box.
3. Complete the Add PID Loop dialog box as detailed below, and then click OK.

Add PID Loop 3
A— —— Marne: |
B ———— Desciription: |
C——Inpu |IHD Point j |ao\u"out55_DIJEID ﬂ I Square Roo—1+——D
E —f— LowRangs: |0 High Ranges: |10
F— —— Setpaint: |IHD Pairt j |aoVout55_DEIEID j
G ——Outpuk [I/0 Paint | |aohout55_0000 ]
H ———— Lower Clamp: |-10 Upper Clamp: |10
| ———— Min Change: |0 Max Change: |0
Output options for when the input iz out of range
J | ™ Switch to manual mode when input goes out of range
[ Force output when input is out of range [auta mode only]
N
K ———— algorithm:  |Welacity - Type © « | Gain: |'| Feed Fwd Initial; {0 0
L ——F— Made: Auto v | [Tumel: i} W Feed Fwd Gain: (0
M —— ScanBRate: |1 zec. | Tune [: a J P

Ok | Cancel |
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Name: Type a unique, descriptive name for the PID. The name must start with a letter and may
contain letters, numbers, and underscores (spaces are converted to underscores).

Description: (Optional) Enter a description of the PID.

Input: Select the type of input: I/0 Point, PLC, or PID Output.

—  Ifthe PID’s process variable comes from an I/0 point on the same unit, select /O Point. Choose
the point from the drop-down list or type a point name to configure a new point.

- Ifthe PID’s process variable comes from the Allen-Bradley controller, select PLC. Enter an initial
value for the input.

—  Ifthe PID’s process variable is the output of another PID on this brain (a cascading control loop),
select PID Qutput. Choose the PID from the drop-down list.

Square Root: (Optional) If you chose I/0 Point or PID for step C, check this box if the error should be
calculated based on the square root of the process variable (applies to flow control systems where
volumetric flow is proportional to the square root of a signal from a flow transducer).

Low/High Range: Set the valid range of the process variable by entering the low range and the high
range. (See Output Options for optional responses to out-of-range input.)

Setpoint: Choose the source for the setpoint: 1/0 Point, PLC, or PID Output.

— To control the setpoint using a device (on the same brain) such as a potentiometer, select I/O
Point; choose an 1/0 point from the drop-down list or type a new point name.

- To control setpoint using the Allen-Bradley controller, select PLC. For Initial Value, enter the most
common operating value.

- Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

Output: Choose the destination for the PID output: /0 Point or PLC. (To use the output for controlling
the setpoint or input of another PID, choose PLC.)

Lower Clamp/Upper Clamp: Enter upper and lower clamp values to prevent the output from
exceeding a desirable range. These values should equal the range of the output point, if used. Or
choose values to make sure that the output device doesn't shut off (for example, keeping a circulation
pump running regardless of the PID output) or that the output never reaches a destructively high
setting (for example, keeping a motor below maximum).

Min Change/Max Change: (Optional) Enter minimum and maximum change values. The output
won't respond until the minimum change is reached (for example, you may not want a heater to turn
on to correct a 1 degree error). Maximum change prevents too drastic a change in output (for
example, you could limit the increase in a pump's output to prevent pipe breakage). The default for
both minimum and maximum is zero, which disables the feature.

Output Options: Choose how the PID should respond if the input goes out of range. To have RSLogix
logic or an operator respond, check Switch to manual mode. To force the output to a specific value,
check that option and type the output values.

NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID put
into manual mode; but if the PID is already in manual mode, the output will not be forced.

If neither box is checked and the PID input goes out of range (as defined by E— High/Low Range) then the output
will freeze, but only while the input is out of range.

K

L

Algorithm: Choose an algorithm: Velocity (Type C), ISA, Parallel, or Interacting. For details on
algorithms, see “Algorithm Choices”on page 79.

Mode: Choose the Mode you want the PID to be initialized to. The main difference between
Automatic and Manual mode is that in Manual mode the PID loop stops its mathematical calculation.
In both modes the PID's output value is still copied to the analog output.

—  Auto mode: The PID makes calculations based on the difference between the input and the
setpoint resulting in changes to the output, which causes the input to move toward the
setpoint.
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- Manual mode: The PID stops making changes to the output, but continues to write the PID
output to the analog point (or configured destination for the PID output). Manual mode allows
RSLogix logic or an operator to control the PID output, which in turn is written by the PID loop
to the analog point (or configured destination of the PID output).

NOTE: Ifthe value of the analog point or configured destination is changed, it will be overwritten by the PID
output.

PID
Setpomt
Analog
Input Output Output

Scan Rate: Enter a scan rate to determine how often the input is scanned and the controller output
is calculated. Minimum value is 0.001 (1 ms). Scan time should be greater than system lag (the time
it takes for the controller output to have a measurable effect on the system). Also consider other PIDs
and tasks on the brain competing for processing power.

Gain: Type a positive or negative value for Gain. Heating systems usually require a negative value and
cooling systems a positive value.

NOTE: Gain is usually refined during the tuning process.

Fd Fwd Initial/Fd Fwd Gain: (Optional) Enter Feed forward Initial and Feed forward gain values if
you need to offset the controller output in your application. These values are constants that are
multiplied and added to the controller output; often they are not used in PIDs.

Tune I/Tune D: (Optional) Type Integral and Derivative settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined
in the tuning process.

Changing a PID Loop

You can change the PID loop's configuration and its position in the I/O unit.
1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops tab.

The Configure PID Loops tab lists all configured PID loops. Remember that the number of PID loops
available depends on the Opto 22 device.

# 96pidloops - EtherNet/IP. Configurator

File Edit Tools View Help
LD ?
-I- Add new device... -
Selected +- inS5Wout Configure /0 Modules & Points - Configure PID Loops l Configure Assemblies ] Lli
] +- inSEHDAPIDSE
device - Discovered Devices # | Name Input Setpoint A
00-A0-30-01-30-99 m ai56HDA 0000 [PLC [
pldUUEH aibEHDA,_0007 FLC Q
02 pid0002 aigEHDA,_0002 FLC Delete
03 pidd003 aigEHDA,_0003 FLC 4
04 pidd004 aigEHDA,_0004 FLC M odify
05  pidd00s aigEHDA,_0005 FLC Q
06 pidiooe aSEHDA_DODE  PLC E Up- and down-
07 pidd007 aigEHDA,_0007 FLC
08 pdo00s aiBEHDA D100 PLC &l arrows
Ready MM

PID loops are scanned by the I/0 unit in the order that they appear in this list.
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2. Tomove the PID loop to a different position on the /0 unit, use the up- and down-arrows in the dial
box.

3. Tochange the PID loop's configuration, double-click its name to open the Edit PID Loop dialog box.
Change the fields as necessary.

For help in completing the fields, see “Adding a PID Loop” on page 75.

Deleting a PID Loop

09

Only PID loops that have a reference count of zero can be deleted. Be careful when deleting PID loops; you

cannot undo a deletion.
1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops tab.
2. Right-click the name of the PID loop and choose Delete from the pop-up menu.

The PID loop is deleted.

You can also delete a PID loop in the Configure PID Loops dialog box by highlighting it and clicking
Delete.

Algorithm Choices

When you configure a PID loop, choose one of these algorithms1:
o Velocity (Type Q)

« ISA

o Parallel

« Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are

derived from the article “A Comparison of PID Control Algorithms”by John P. Gerry in Control Engineering
(March 1987). These three equations are the same except for the tuning coefficients; converting from one
equation to another is merely a matter of converting the tuning coefficients.

The following obsolete algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22
KnowledgeBase article KB82058KnowledgeBase article KB82058.
+ Velocity (Type B) Obsolete
- ISA (Obsolete)
- Parallel (Obsolete)
« Interacting (Obsolete)

Do not use these obsolete algorithms with groov RIO. For other devices, you can continue to use them, but Opto 22
recommends you use the new algorithms when configuring new PID loops.
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INSPECTING AND TUNING PID LOOPS

Key to Terms Used in Equations

Process variable; the input to the Derivative tuning pqrameter. !n units
PV PID TuneD of seconds. Increasing magnitude
increases influence on output.
SP Setpoint Output Output from the PID
InL \ — i-
n (.)' Range of the input Err 1 The Error (PV — SP) from the previ
InHi — ous scan
OutLo Integrator. Anti-windup is applied
o tH', Range of the output Integral | after the outputis determined to be
uthL within bounds.
Gain Ppmmmmummgm@maa. PV1, PV2 PV from the previous scan and the
Unitless. May be negative. scan before that.
Integral tuning parameter. In ynlts . Actual scan time (time since previ-
Tunel of seconds. Increasing magnitude ScanTime
. . ous scan)
increases influence on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting
Integral = Integral + Err
TermP = Err

TermI = Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )
Velocity (Type C) Algorithm

ATermp = ( PV - PV1 )

In this part of the formula, you adjust Tunel.
ATermI = Tunel * ScanTime * Err

In this part of the formula, you adjust TuneD.
ATermD = TuneD / ScanTime * ( PV - 2 * PVl + PV2 )

In this part of the formula, you adjust Gain.
Aoutput = Span * Gain * ( ATermP + ATermI + ATermD )

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + TermI + TermD )

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + TermI + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + TermI ) * ( 1 + TermD )

INSPECTING AND TUNING PID LOOPS

Using EtherNet/IP Configurator, you can view PID loops and tune them. This section gives you basic steps for

inspecting PIDs, determining system lag, and tuning PIDs. See also Opto 22 form 1641, Optolutorial: SNAP PAC
PID, which we highly recommend for detailed information on PIDs on Ethernet-based 1/0 units. Form 1641 is

available for download from our website at www.opto22.com.
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Inspecting a PID

1. With a configured PID downloaded and running on the brain, click the Configure PID Loops tab.
2. Highlight the PID, and then click the Tuning button.

3.5 "pid0” - View PID Loop (scanning)

Mame: |pidD Error: |N0ne
Input; 79,2753 Gain: -15 ScanRate: |3 zec, tode: ko El:
Setpaoint: |79 Tunel: |0.05 Scan Counts: |112783
Output;  |2.252521 Tune D |0.02
Click a tab to see or change
additional data. Plot ] 140 Detalls | Misc. Details | Velocity Algorithm |

Setpoint and Input plot. Adjust—
resolution using the Input Axis
button below the plot. Click

and drag on the scale to move

the line.

Output plot.

Adjust resolution using the
Output Axis button. Click
and drag on the scale to
move the line.

Time axis. Adjust resolution
using the Time Axis button.
Click and drag left or right to [ Data | [Input Axis b | [Dutout Axish ][ Time Asis b |

see other times.
Cloze | |

3. View or change PID parameters as necessary. Click the other tabs to see additional data. To tune the PID,
see page 86.

To save, copy, or print the current plot, click the Data button and choose from the popup menu.
5. Tosave changes to any of the PID configuration parameters, click Save Tuning.

Determining System Lag

You can directly control the PID output to determine system lag, which is essential to setting the PID scan rate.
Also see Opto 22 form 1641, Optolutorial: SNAP PAC PID, available for download from our website at
WWWw.opto22.com.

1. Determine two significantly different output settings that are within the capabilities of your system.
2. With a configured PID downloaded and running on the brain, click the Configure PID Loops tab.
3. Highlight the PID, and then click the Tuning button.
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3.5 "pid0” - View PID Loop (scanning)

Name:  |pid0 Eror: |Mone
Input: 79,2753 Gain: 15 ScanRate: |3 ZEC. Mode: |Auto 3:
Setpoint: |79 Tunel: (005 Scan Counts: 112783

Dutput: |2.2525621 Tune O (002

Plot | 1/0 Details | Mise. Details | Velacity algorithr |

= (utput

Data  p ][Input Bz B ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS » ]

Cloze | |

Set the Mode to Manual (if not set already) and click Apply.

In the Output field, type one of your two output settings and click Apply.

Use an output value typical of your system but low enough to allow you to change output by 20%.
Reset your time axis, if necessary, by clicking the Time Axis and choosing from the popup menu. Then
choose Reset Scale Tracking from the same menu.

The span setting varies according to your system; a 3-minute span is often suitable. Until you are familiar
with the PID plot, it is recommended that you avoid using the shortest settings (10-seconds or 1-second).
After you've observed a change in the input, you can zoom in on the graph, which is described later.
Wait for your system to stabilize.

The system is stable when the Input value does not vary significantly (some drift can be expected).
Stabilization may take several minutes, depending on the system.
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A stable system exhibits little
change in the Input value,
which is shown numerically
and graphically.

Adjustresolution of the

Input Axis by clicking the
Input Axis button.
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—_

| lnpak—|77. 32614 Gain: il ScanBate: |1 ZEC. Mode: |Auta =

| [ Data—F ] Center an Setpaint ]

3'“"TemperatureControl” - View PID Loop (scanning)

Mame:  [pidd Ermar: |Mone

Setpoint: |90 Tunel: |0 Scan Counts: | 249642
Qutput |30 Tune D |0

Plat | 140 Details | Misc. Details | Welocity lgorithm |

100 Reset Scale Tracking

View 200%: Span
iew 100%: Span
‘iew S0%: Span
View 25% Span
View 10% Span
5 an

View 1% Span

Cenker an Inpuk

Cloze | |

8. Increase the resolution of the Input Axis by clicking the Input Axis menu and choosing a span setting of 1
or 5 percent.

9. Center the Input Axis, if necessary, by clicking the red line at its left end and dragging it up or down until
the plot s visible.

10. Under the Time Axis menu, choose Reset Scale Tracking.

This is a precautionary step, as changing settings on the plot can fix the plot at a certain point in time.
Resetting the time axis ensures that you are viewing the real-time values.

11. In the Output field, type the other of your two output settings and click Apply.

A 20% percent increase is a moderate, detectable change for most systems. Your system may require a
larger or a smaller change to stay within safety constraints.

12. Wait for a discernible change in the Input axis.
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Plat ] 10 Detailz | Mizc. Details | Welocity Algorithmm

The Input axis (indicated by
the upper white arrow added
to this picture) begins to
respond to the change in
output (lower white arrow).

[ Dats  » ][InputA:-:is » ][Dutput.&xis) ][Time.t‘-‘mis » ]

13. Increase the resolution of the Time Axis by clicking the Time Axis button and choosing a lower
percentage, such as View 1 Minute Span.

14. Scroll the Time Axis to locate the point at which you changed the Output.

Both the time and input axes should display the point at which the Output changed, the lag, and the
point the input changed. If not, adjust the Input axis and Time axis, until this information is displayed.

Plat | 140 Details | Misc. Details | Velacity Algorithm |

[ Data  » ][Input.&xis » ][Dutput.&xis} ][Time Bz p ]

15. From the Data menu, select Cursor.
The data cursor, a line with a value bar attached to it, appears on the plot.
16. Right-click the data cursor and choose Delta X from the Style submenu, as shown below.
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Plat ] 140 Detailz | Mizc. Details | Yelocity Algorithm

oint

= Output

3 v Walue X-Y

Flip Alignment Delta ¥

[ Data  » ][Input.&xis » ][Dutput.t‘-‘mis) ][Time Bz B ]

17. To measure the system lag (the time between the change in output and the change in input), click and
drag the first vertical red bar to just after the output change. Drag the second bar to just before the
change in input.

The Delta X cursor displays the Plat l 10 Detailz | Misc. Detailz | Velocity Algorithm
time difference between the two
vertical bars.

Drag the first bar into position
after the Output change.

Drag the second bar to a
position just before the
change in Input.

[ Data  » | [InputAsiz » | [Output dsis b | [ Time Asis » |

If you are unable to get the precision you want, you can view the plot at a lower time span, such as 10
seconds. You will need to reposition your plot and the measurement bars of the Delta X cursor.

The example above shows a system lag of 1.88 seconds. Generally, a suitable scan rate can be anywhere from
one-third the system lag to two times the system lag. Considerations in setting scan rate are:

«  Slower scan intervals may be easier to tune. The PID controller has time to see the effect of the previous
output before calculating a new output.

«  Faster scan rates may be necessary to achieve the desired response. When scan intervals are shorter than
the system lag, tuning must compensate for any over-correction from the controller output.
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Tuning a PID Loop

Tuning a PID involves manipulating the P.1, and D constants in real time. The following steps should be viewed
as general suggestions to show you features that are available for tuning. We highly recommend Opto 22
form 1641, Optolutorial: SNAP PAC PID, for more detailed information. Form 1641 is available for download
from our website at www.opto22.com.

CAUTION: Before following these procedures, make sure you know the limits of the equipment being controlled
and monitored by your PID loop. Also, make sure that these points are configured properly. Any values suggested in
these steps are for example only and must be modified according to the capabilities and constraints of your system.

1. Make sure the following PID features have already been configured:

Scan Rate

Input

Input low range and high range
Output

Output lower and upper clamp
Algorithm

Setpoint. If your setpoint changes during normal operation, tune your PID with the setpoint
configured to host, so you can simulate setpoints from an input point or from another PID.

Gain. Afinal gain constant will be determined by tuning, but before you can tune your PID, your gain
constant must be either a positive or negative number according to the type of system you have.
For example, a heating system reports a negative error when heat needs to be applied; a negative
gain constant turns this error into a positive output for the heater. Alternatively, a cooling system
reports a positive error when the input exceeds the setpoint; a positive gain constant maintains the
positive output to the chiller.

Optional, depending on your system: Minimum and maximum changes to Output and Output
forcing when the Input is out of range.

. With a configured PID downloaded and running on the brain, click the Configure PID Loops tab.
3. Highlight the PID, and then click the Tuning button.
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3.5 "pid0” - View PID Loop (scanning)

15 ScanRate: |3 ZEC.

Name:  |pid0 Eror: |Mone
Input: 79,2753 Gain:
Setpoint: |79 Tunel: (005

Mode: |Euta 3:
Scan Counts: [112783

Dutput: |2.2525621 Tune O (002

Plot | 1/0 Details | Mise. Details | Velacity algorithr |

Data

» ][Input Bz B ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS » ]

Cloze | |

[

Set the PID Mode to Auto (if not set already) and click Apply.
Change the Setpoint, if desired, by typing a new setpoint and clicking Apply. (Setpoint must be

configured as Host.)

Depending on the type of system, your PID may maintain a setpoint or respond to changes in setpoint.
Experiment with setpoint changes again after tuning the P, I, and D constants.

Adjust the span of the input, output, and time axes according to how much change you expect from
your system. To set a span, click the axis button and choose from the popup menui.

If desired, type a new Scan Rate and click Apply.

For most systems, you should use an appropriate scan rate based on the system lag (see “Determining
System Lag”on page 81). However, you can experiment with Scan Rates before tuning the P, I, and D

constants or adjust scan rate after tuning.
Here is an example for Scan Rate:
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3.5 "TemperatureControl” - View PID Loop {scanning)

Name:  |TemperatureCortral Enor: |Mone

Input: 80.24391 Gain: R Scan Rate: |3 SEC. Mode: [Auta 3:
Setpoint: |30 Tunel: |10 Scan Counts: 112783
Qutput: |0 Tuns D |0

Plot | 1/0 Details | Mise. Details | Velocity Aigorithm |
The lag for this system was
determined to be about 2
seconds. The left half of the plot
reflects a 0.5-second scan rate,
while the right half shows a
3-second scan rate. Notice both
scan rates have the same effect
on the input; however, the
3-second scan rateis using less of
the processor’s resources.

Data  p ][Input Bz B ][Dutput.ﬁ.:-:is) ][Time.&xis » ]

Cloze | |

8. Experiment with gain settings by typing a new value in the Gain field and clicking Apply.

The easiest way to tune most PIDs is to experiment with the gain constant first. Try various gains to see
how well the system stays at setpoint and responds to setpoint changes.

The white arrows in the example below show where gain constants of -2, -5, -10, and -20 were applied:
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With only a gain constant
applied, the input often
stabilizes at an incorrect
value. In this heating
example, a gain setting of -30
drove the input close to the
setpoint, but subsequent
increases failed to eliminate
the offset. It is time to try
integral constants to
eliminate the offset error.

9.
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3.5 "TemperatureControl” - View PID Loop (scanning)

Name:  |TemperatureCortral Eror: |Mone
Input: a7.5289 Gain: 20 ScanBRate:  [1.4 ZEC.
Setpoint: (30 Tunel: |0 Scan Counts: 112783

Dutput:  |E1.7775 Tuns D |0

Plot | 140 Details | Mise. Details | Velacity algorithr |

30,00

100

Data  p ][Input Bz B ][Dutput.-’-‘n.:-cisb ][TimeA:-:iS » ]

Mode: |Euta 3:

Input
etpaint
= [utput

Cloze | |

[

In this example, a gain setting of -30 revealed an offset error:

Flot | 140 Detais | Misc. Detaik | 154 algorithm |

000

[ Data

b | [Irput Asis b | [Output dsisp | [ Time duis » |

Experiment with the integral constant: in the Tune | field, type a number between 0 and 1 and click

Apply. (Your PID may require larger numbers.)
In this example, an integral constant of 0.1 corrected the offset error.
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The far left side of the plot shows
the offset before an integral
constant of 0.1 was applied. This b
setting eliminated the offset. In . Input
many applications, a minor
fluctuation around the setpoint is
acceptable, and these applications
use gain and integral only. In some
applications, however, the
fluctuations at the setpointindicate
that the gain is too high (too much
gain makes a system unstable) or
that a derivative constant is
required.

Plat l 170 Detailz | Mizc. Details | 154 Algorithm

Data  » ][Input.ﬁ.:-:is » ][Dutput Az ][Time.f-\:-:is » ]

10. If derivative correction is needed, experiment with the derivative constant: in the Tune D field, type 1 and
click Apply. (Your PID loop may require a larger number)

In this example, a derivative of 10 makes a noticeable difference in keeping the input near the setpoint.

Many PID systems are effectively controlled |G Sy W LT E T ] (=1

W‘th gain and integral constants Omly and Mame: |TemperatureContro| Error: |None
no derivative constant. In this example, the )
. . . . L Input: |SD.D2B28 Gair: |-30 ScanBate: |14 S, Mode: |Auta 3:
gain and \ntegra\ settings are maintaining _
the temperature at 0.06 from setpoint‘ To Setpoint: |SD Ture |: |D.T Scan Counts: |B1281
demonstrate the effect of the derivative Duput [B671083  Tune : [10

constant, the resolution of the mput axis Plot l 140 Details | Misc. Details] Welocity Algorithm
was increased to show a 1 percent span. At
this resolution, the plot reveals changes of
0.01 degrees F.

The left side of the plot shows the effect of
gain at-30,integral at 0.1,and no derivative
constant. The arrow shows when a
derivative constant of 10 was applied. The
right side of the plot shows how the
derivative constant is keeping the input —_— e Ay —
closer to setpoint.

[ Data  » ][Inpuleis » ][DulpuleisP ][TimeAxis » ]

Close | |

11. Click Save to save your tuning parameters to the configuration.

Changes are lost unless you save them. You may wish to save your tuning parameters when you see any
improvement in performance, even if they are not final.

90 I04AB User's Guide



Etheriet/IP Configurator,

‘? %

2
Gain:

Ture It
Tume D:
Scan rate:
Feed forward:
Feed forward gain:
Cukput min change:
Qutput max change:

Do wou want ko conkinue?

Qutput when input is under-range:
Cutput when input is over-range:
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The Following values will be permanently saved to the device:

-5.000000
10,000000
200, 000000
3.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000

X

12. Click Yes.

Values are saved to the EtherNet/IP configuration file. Remember to download the configuration to the
Opto 22 device. (See "Downloading a Configuration”on page 67.)

USING I/0 POINT FEATURES

The I/0 point features available on remote /0O depends on the combined capabilities of the device (brain or
on-the-rack controller). See the device's data sheet for supported features.

The following tables define the digital and analog features that are supported. For more information, see form
1704, the PAC Manager User's Guide. See also form 1798, the SNAP I04AB Learning Center User’s Guide.

To see video demonstrations for using I04AB, go to Products > Product Families > I04AB on the Opto 22
website and click the link to watch Opto 22 for Allen-Bradley videos.

Digital Features

Feature Description

(input)—A counter keeps track of the number of times a digital input changes from off to on.

The count accumulates until it reaches the maximum count available in the remote I/O or until

you reset the counter to zero. For example, to count the number of widgets produced per shift,
Counters you would clear the counter at the start of each shift and read it at the end of each shift.

For points on a 4-channel module, the speed of the counter depends upon the brain or control-

ler’s capabilities and the speed of the module used. For points on a high-density module,

counting is done in the module.

Frequency
measurement

(input)—Frequency is the speed with which a digital point changes state and is usually mea-
sured in counts per second. For example, reading the frequency can help you determine the
speed of rotating machinery.

(input)—When the value of a digital input point changes from off to on, an on-latch is automat-

Latches

ically set. While the value of the point may return to off, the on-latch remains set, as a record of

the change, until you clear it. Similarly, an off-latch is set when the value of a digital point
changes from on to off, and it remains set until cleared.

Period
measurement

(input)—Period refers to the elapsed time for a complete on-off-on transition on a digital point.
Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the next

transition of the same type (one-time or continuous or both).

Pulse duration  (input)—A pulse is a brief on (or off) state, usually repeated at a specific interval. The brain can
measurement  measure the first pulse, that is, the amount of time the input stays on (or stays off).
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Feature Description

(input)—A quadrature counter requires a SNAP quadrature input module, which is attached to

CQouuarﬁ;tsure the encoder device. The module sends a pulse to the remote 1/0 upon each change in quadra-
ture state, and the remote 1/O counts the pulses and keeps track of the direction and rotation.

States (input and output)—Automatic, not configurable. A digital point is either on or off. You can read
the current state of a digital input or write an on/off state to a digital output.

Time-propor- (output)—Time-proportional output varies the duty cycle and the percentage of on time within

tional output that cycle. TPO is often combined with a PID loop and used to control the output, for example

(TPO) in a heater or oven.

(digital and analog points)—A watchdog monitors communication to the device. If nothing
accesses the port for the length of time set in the watchdog, the remote 1/0O automatically sets
designated digital and analog I/O points to the values you have determined.

Watchdog A watchdog helps make sure that a communication failure doesn’t result in disaster. If no com-
munication is received for the length of time set in the watchdog, the watchdog makes sure the
process is automatically brought to a safe state. For example, a valve could automatically
close to avoid completely emptying a tank.

Digital totalizers track the total time a specific input point has been on or off. For example, you
could track how long a pump, fan, or motor has been on. Digital totalizers are useful for peri-

odic maintenance. Before using a totalizer, you must configure the point with this feature. The
availability of totalizers depends on the brain; see the brain’s data sheet for more information.

Totalizers

Analog Features

Feature Description

Average filter (analog inputs)—A filter weight smooths analog input signals that are erratic or change sud-
weight denly.

(analog output)—Clamping limits values that can be sent to analog output points so they do
not go above or below a specific value. For example, if you are using a 0—10 VDC output

Clamping module, but the device attached to one of its points can only handle a maximum of 5 VDC,
you can set an upper clamp of 5 VDC for that point. The values for upper and lower clamp are
set in engineering units.

(analog input)}—Minimum and maximum values are sometimes called peaks and valleys. You
Minimum and can read these values at any time, for example, to record minimum and maximum tempera-

maximum tures. You can also reset min/max values. For example, if you want to record the maximum
values temperature at point 2 in each 24-hour period, you must reset the values after they are read
each day.

(analog input)—Offset and gain calculations are used to calibrate analog points. If a -50 mV
to +50 mV input receives signals that are slightly off (not exactly -50 mV at the lowest point,

for example), the offset and gain can be calculated so that values will appear accurately when
read.

Offset and gain

(analog points)—Proportional integral derivative (PID) loops are used to drive an input toward
a particular value (the setpoint) and keep the input very close to that value by controlling an
output. PID loops are often used in temperature control.

PID loop
control

(analog output)}—Some devices attached to analog outputs should not be abruptly stepped
Ramping up or down, because a sudden change might damage the equipment or cause other prob-
lems. Instead, you can gradually ramp the device up or down to the desired value.

(analog input and output)}—Analog input and output points can be scaled as needed. For

Scaling example, you can scale a -5 V to +5 V input point to reflect 0% to 100%

(analog input)—Automatic, not configurable. The remote 1/0O automatically converts the ther-
Thermocouple mocouple junction's millivolt values into temperature values, so you don’t have to. Choose
linearization the appropriate module and make sure you configure the point as the correct thermocouple
type (E, K, etc.) for your purpose.
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Feature Description

(digital and analog points)—A watchdog monitors communication to the device. If nothing
accesses the port for the length of time set in the watchdog, the remote I/O automatically sets
designated digital and analog I/O points to the values you have determined.

Watchdog A watchdog helps make sure that a communication failure doesn’t result in disaster. If no
communication is received for the length of time set in the watchdog, the watchdog makes
sure the process is automatically brought to a safe state. For example, a valve could auto-
matically close to avoid completely emptying a tank.

REFERENCING I/0 POINTS ON SNAP PAC RACKS

This section shows input and output point numbers for SNAP PAC mounting racks, which can hold up to 4, 8,
12, 0or 16 Opto 22 SNAP I/0 modules.

Each module contains 1 to 32 points (channels), depending on the module. Examples of modules are shown
in the following diagram.

NOTE: Each channel of a SNAP PAC /0 module provides connectivity to one point of /0. Each channel of a SNAP PAC
communication module provides connectivity to one communication port.

/Modu\e positions

Module position 0, 4-ch digital: -l

ponis [3[2[ 10 |

) Y

] 1E

Module position 6, high-density digital: : 6

Points: (31|« [ 0| ] iy
8§ 8 <« Module position 8, analog:

3: ——y 9

Points:‘7‘6|5|4|3|2|1|0‘

| |
— O

]

12 4—Module position 12, analog:
5 e T ] 0]
14

15

|

Module position 14, serial:

Ports: E

Hawm_ |

S

[
1
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A: Supported Allen-Bradley
Platforms

Opto 22 supports using the ControlLogix” and CompactLogix™ controller platforms with Opto 22 SNAP 1/0.
Both of these platforms support Implicit Messaging (also known as I/0 messaging) and Explicit Messaging.

The following Allen-Bradley platforms also support EtherNet/IP While some controllers in these platforms only
support explicit messaging, Opto 22 may be able to assist you in using them.

«  MicroLogix™ 1100 and 1400 (Series B FRN4 or newer)

NOTE: Some Allen-Bradley controller platforms have only specific models that support EtherNet/IP or require an
adapter module or card.

For a complete and up-to-date list of Allen-Bradley platforms that support EtherNet/IP, and more information
on which platforms support Implicit Messaging or Explicit Messaging only, contact Rockwell Automation.
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B: Using Counts

This appendix describes using counts with EtherNet/IP and linearizing the Pt100 and Pt1000 probes from
resistance.

IN THIS APPENDIX

Using Counts with EtherNet/IP 97
Linearizing the Pt100 and Pt1000 Probes from Resistance.................. 99

USING COUNTS WITH ETHERNET/IP

While Opto 22's SNAP PAC IO4AB implementation provides many configurable options for reading and writing
/0 (including robust scaled units) as an Allen-Bradley user you can still use counts if you want to. However,
using counts has various limitations due to the brain’s capability to linearize the counts provided by the
modules.

How to Retrieve Counts

When creating assembly instances in the EtherNet/IP Configurator, there are two types of values for analog
inputs and outputs, rValue and Value. Selecting rValue will report the value as a 32-bit float or a Logix REAL
data type. Value is the 16-bit integer value of counts as an input.

In the SNAP PAC architecture, the notion of counts varies with the particular module being used.

Most Analog Inputs

Most SNAP analog input modules provide a counts range of 0 to 24,999 counts for unipolar modules (which
read zero to a positive valued input) and —24,999 to 24,999 counts for bipolar modules (which read a negative
to positive input range).

The analog input range determines the limits of the counts. For example, a SNAP-AIV has either a 10 VDC or
a =5 VDCinput range. This range is selectable in the EtherNet/IP configuration. When set to the +10 VDC
input range, 24,999 counts is 10 VDC and —24,999 counts is =10 VDC. If the module is set to the +5 VDC, 5 VDC
is 24,999 counts and -5 VDC is —24,999 counts.

Opto 22's SNAP analog inputs also allow 10% over range. This means that for the SNAP-AIV module, the actual
maximum range is +11 VDC or +5.5 VDC. This absolute range is 10% beyond the advertised module limit,
which means the counts may have a maximum magnitude of 27,499 counts.

NOTE: Any range outside of 27,499 counts magnitude is considered an invalid and out-of-bounds condition.
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Analog Input Exceptions

This section applies to the following modules and associated modes (including any —FM [OBSOLETE}
designated parts):

«  SNAP-AICTD

«  SNAP-AICTD-8

o SNAP-AITM (in thermocouple mode)

o SNAP-AITM2 (in thermocouple mode)
o SNAP-AITM-i (in thermocouple mode)
o SNAP-AITM2-i (in thermocouple mode)
«  SNAP-AITM-8 (in thermocouple mode)

When these modules are configured in their temperature mode, they will output counts that are 10 times the
linearized temperature value.

For example, if a SNAP-AITM has a “J"thermocouple input and it is reading 123.4F, the counts reported with
1234 (as a 16-bit signed integer).

Resistance Temperature Inputs

SNAP-AIRTD 1/0 modules (including the SNAP-AIRTD-1K and SNAP-AIRTD-10), the SNAP-AIR40K-4, and the
SNAP-AIR400K-8 are resistance modules.

Linearized temperature for SNAP-AIRTD modules is available for Pt100 and specific nickel based probes. The
SNAP-AIR40K-4 and SNAP-AIR400K-8 are strictly resistance modules but may be used for higher impedance
probes, such as a Pt1000.

To read the temperature linearized SNAP-AIRTD modules, read the scaled engineering units. If counts are used,
they will represent the input value as wire compensated ohms. Wire compensation means that the module
provides instrumentation wire resistance compensation internally. For the SNAP-AIRTD modules, 0 counts
means 0 ohms. 24,999 counts indicate 400 ohms. A 10% over range is provided so 27,499 will be reported for
440 ohms of input resistance.

If you are using counts for the SNAP-AIRTD modules, the SNAP-AIR40K-4, or the SNAP-AIR400K-8, you must
provide your own linearization. In this case, using scaled engineering is recommended.

For additional information on determining the temperature from the probe resistance, see “Linearizing the
Pt100 and Pt1000 Probes from Resistance” on page 99.

Load Cell Inputs

When using the SNAP-AILC and SNAP-AILC2 load cell modules, only use the scaled engineering units. These
modules output a higher resolution as counts, which is too large of a number for a 16-bit signed integer (a
type INT) too handle.

NOTE: Firmware versions R8.5 and newer support the load cell module. Use the Load Cell assembly class (not the
Analog Input class) for load cell values.

Analog Outputs

SNAP analog output modules are based on 12-bits. Unipolar output modules have a range of 0 counts to 4095
counts. Bipolar have a counts range of —4096 to 4095. Analog outputs do not have the 10% over range that
analog inputs have.
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LINEARIZING THE PT100 AND PT1000 PROBES FROM RESISTANCE

If you would like to use counts strictly for the SNAP-AIRTD and thermistors for the SNAP-AIR40K modules,
tables in slope-intercept format are provided below. The Pt100 probe table may also be used for Pt1000
applications. For Pt1000 applications, divide the resistance by 10. The SNAP-AIRTD should be used for the
Pt100 and the SNAP-AIR40K should be used for the Pt1000. When using the Pt1000, use the 0-5000 Ohm
input range with the SNAP-AIR40K.

To use these tables, start by searching from the lowest resistance value of the table. Compare the resistance
value until you reach the last value before the table’s resistance exceeds your measured value.

Take the slope and intercept and compute this equation using floating-point variables.:
temperature = (slope from table) x (measured resistance) + (intercept from table)

To convert from Celsius to Fahrenheit, use this equation:
Temperature(F) = Temperature(C) X (1.8) + 32

For better accuracy using probes with the SNAP-AIR40K module, short the leads at the probe’s terminal blocks
and record the resistance measurement. This is the resistance offset due to the instrumentation wiring.
Subtract this value from the resistance measurement before using the linearization table.

Resistance Slope Intercept
68.0 -208.2 2.13121

73.0 -203.397 2.065415
78.0 -198.394 2.001275
84.0 -193.147 1.938809
90.0 -188.091 1.882628
96.0 -182.791 1.82742

103.0 -177.189 1.77304

110.0 -171.674 1.722901
117.0 -166.205 1.676152
124.0 -160.374 1.629129
132.0 -154.119 1.581747
140.0 -147.819 1.536746
148.0 -141.452 1.493727
156.0 -135.005 1.452396
164.0 -128.069 1.410108
173.0 -120.599 1.366925
182.0 -113.014 1.325248
191.0 -105.321 1.284971
200.0 -97.5315 1.246025
209.0 -89.6599 1.208362
218.0 -81.2915 1.169975
228.0 -72.4124 1.131032
238.0 -63.4985 1.093578
248.0 -54.5737 1.057591
258.0 -45.6613 1.023047
268.0 -36.3519 0.98831

279.0 -26.2247 0.952012
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Resistance Slope Intercept
65.0 -182.127 1.533316
87.0 -179.959 1.508399
100.0 -176.723 1.476043
110.0 -172.557 1.438171
119.0 -167.486 1.395552
128.0 -162 1.352695
137.0 -156.357 1.311506
146.0 -150.64 1.272347
155.0 -144.621 1.233515
165.0 -138.325 1.195359
175.0 -131.967 1.159026
186.0 -125.596 1.124774
197.0 -119.322 1.092927
208.0 -112.759 1.061371
220.0 -105.979 1.030556
232.0 -99.093 1.000874
245.0 -92.0848 0.972269
258.0 -84.7268 0.943749
271.0 -76.8096 0.914535
284.0 -68.4858 0.885226
297.0 -59.9087 0.856347
310.0 -51.1933 0.828232
323.0 -42.291 0.800671
337.0 -33.3737 0.77421

351.0 -24.5218 0.748991
366.0 -15.9767 0.725644
Resistance Slope Intercept
17.0 -242.952 2.323969
26.0 -243.957 2.362626
35.0 -245.257 2.399766
45.0 -246.907 2.436427
56.0 -248.793 2.47011

67.0 -250.836 2.500594
79.0 -253.104 2.529302
92.0 -255.638 2.556855
106.0 -258.572 2.584534
120.0 -261.869 2.612006
133.0 -265.501 2.639312
146.0 -269.615 2.667492
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Resistance Slope Intercept
159.0 -274.242 2.696595
172.0 -279.416 2.726672
185.0 -284.944 2.756555
197.0 -290.783 2.786194
209.0 -297.182 2.81681

221.0 -304.176 2.848458
233.0 -311.804 2.881198
245.0 -319.755 2.913648
256.0 -327.971 2.945745
267.0 -336.831 2.978926
278.0 -346.374 3.013254
289.0 -356.646 3.048797
300.0 -367.181 3.083915
310.0 -377.91 3.118524
320.0 -389.366 3.154325
330.0 -401.597 3.191389
340.0 -414.654 3.22979

350.0 -427.878 3.267574
359.0 -441.182 3.304632
368.0 -455.294 3.34298

377.0 -470.266 3.382694
386.0 -482.558 3.414538

APPENDIX B: USING COUNTS
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C: Worksheets and Calculations

This appendix provides a variety of worksheets to help you determine your system’s requirements.

IN THIS APPENDIX

EtherNet/IP TCP/IP Requirements PLC WOrkSheet....ocveeecrssveerren 103
EtherNet/IP Multicast Requirements PLC WOrkSheet. ... 104
SNAP PAC Connection Worksheets 104
EtherNet/IP Module Packet Rate Limits 105

ETHERNET/IP TCP/IP REQUIREMENTS PLC WORKSHEET

Each EtherNet/IP application should be reviewed for its TCP/IP connection requirements. The following
worksheet will assist in determining the number of connections required for each Allen-Bradley PLC within the
system.

TCP/IP Connections (for each PLC in the system)

Question Quantity

RSLogix connection to the PLC using EtherNet/IP (enter 1 here)

How many RSLinx or 3™ Party OPC/DDE Servers?

How many PAC devices will be accessed via an unconnected MSG instruction?
How many other (non Opto 22) EtherNet/IP devices?

How many Logix to other EtherNet/IP PLC TCP/IP connections?

How many remote PLCs will connect to this PLC using a TCP/IP connection?
How many Generic Ethernet Modules are defined?

Total number of TCP/IP connections (sum the “Quantity” column together)

Depending on the specific PLC or EtherNet/IP module, your application could exceed the TCP/IP connection
resources. If you are using ControlLogix, you can use additional EtherNet/IP modules.

Typically, ControlLogix modules may support 64 (1756-ENBT) or 128 (1756-EN2T or 1756-EN2F) TCP/IP
connections. CompactlLogix typically supports 32 connections.

For the specific TCP/IP limitations of your PLC, see Allen-Bradley form enet-um001_-en-p.pdf.
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ETHERNET/IP MULTICAST REQUIREMENTS PLC WORKSHEET

MicrolLogix PLCs such as the 1100 and 1400 support 8 TCP/IP connections. This limit is described in each
product’s published specifications.

ETHERNET/IP MULTICAST REQUIREMENTS PLC WORKSHEET

Each EtherNet/IP application should be reviewed for its multicast requirements. The following worksheet will
assist in determining the number of connections required for each Allen-Bradley PLC within the system.

Multicast Connections (for each PLC in the system):
Question Quantity Total

How many “Generic Ethernet Modules,” with status?
How many remaining “Generic Ethernet Modules?”
How many consumed tags to other EtherNet/IP PLCs? 2
How many produced tags to other EtherNet/IP PLCs?

Total Number of Multicast Connections (add “Total” column together)

This total reflects the total number of CIP connections required for the application. Use the latest version of the
EtherNet/IP Capacity Tool to accurately determine limits of your application. This is only necessary in
applications that have large numbers of I/0 especially when PLCs themselves are producing and consuming

tags.

NOTE: Only some of the ControlLogix EtherNet/IP modules support implicit messaging. The modules that support
implicit messaging are the 1756-ENBT, 1756-EN2T and the 1756-EN2F EtherNet/IP modules.

SNAP PAC CONNECTION WORKSHEETS

104

Complete the following worksheet for each SNAP PAC brain or controller used within an EtherNet/IP system.

EtherNet/IP SNAP PAC Multicast Connection Worksheet

The SNAP PAC brain or controller supports 16 multicast connections. If this limit is exceeded, EtherNet/IP
modules will have difficulties connecting to the SNAP PAC brain or controller.

Question Quantity Total

How many “Generic Ethernet Modules,” with status? )
X

How many remaining “Generic Ethernet Modules?”

Total number of Multicast Connections (add “Total” column together)

EtherNet/IP SNAP PAC Encapsulation Connections

The SNAP PAC brain or controller supports 16 CIP encapsulation connections (for EtherNet/IP). The following
worksheet will assist to determine the application requirements for each SNAP PAC device within the
Allen-Bradley system.

Typically for explicit messaging, a PLC will create one encapsulation using TCP/IP connection to the PAC. Use
only unconnected messaging (configured in the MSG instruction). This will ensure that the PLC will not
quickly exceed the encapsulation connection limit of the PAC.
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APPENDIX C: WORKSHEETS AND CALCULATIONS

The PLC will also create a UDP encapsulation connection for each implicit messaging multicast session.

Question Quantity Total

Number of PLCs with Explicit Messaging access
Total Generic Ethernet Modules w/Status accessing this device x2
Total Generic Ethernet Modules accessing this device

Total Number of Encapsulation Connections Consume

ETHERNET/IP MODULE PACKET RATE LIMITS

Implicit Messaging Volume

To determine the total volume of packets generated by the implicit messaging, use one of the following
equations. You will need to know the requested packet interval (RPI, in milliseconds) of each Generic Ethernet
Module.

When using a Generic Ethernet Module with Status:

Packet Rate per Second (for each Generic Ethernet Module) = 4000/ RPI
When using all other Generic Ethernet Modules:

Packet Rate per Second = 2000 / RPI

The total implicit messaging packet rate is the sum of all of the packet rates of all the configured modules on
the PLC.

Explicit Messaging Volume

Explicit messaging is determined by the rate the PLC logic decides when to initiate a message sequence. By
determining the maximum number of MSG commands per second, you can use this number to estimate the
maximum packet rate as follows:

Packet Rate per Second = 2 X maximum MSG commands per second

The total packet rate generated by implicit and explicit messaging is the sum of the implicit message packet
rate and the explicit message packet rate.

10 Packet Rate = Implicit Packet Rate + Explicit Packet Rate

Typically a ControlLogix 1756-ENBT module has a maximum packet rate of 5,000 packets per second. A
CompactlLogix PLC has a throughput of 4,000 packets per second. Allen-Bradley form ENET-APO01D-EN-P
specifies the entire calculated rate should not exceed 90% of the maximum packet rate of the EtherNet/IP
module.

The calculations described above only accumulate a portion of the EtherNet/IP messaging rate. We strongly
recommend reviewing Allen-Bradley forms ENET-AP00T and 1756-RM094 to ensure that all other sources of
EtherNet/IP traffic are considered when validating your system design.

The Ethernet topology and switches are also responsible for the response rate and maximum throughput of
an EtherNet/IP implementation. We encourage you to evaluate the performance of your Ethernet network
topology.
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D: Connecting with MicroLogix

This appendix provides information for connecting to a MicroLogix 1100 or 1400 PLC.

You can use a MicrolLogix 1100 (Series-B) or 1400 to read and write I/O data using I04AB. Assembly Instances
configured in the EtherNet/IP Configurator may be read and written using the MSG instruction.

Each MSG instruction must have its own RIX Extended Routing Information and Message files. Add these files
before configuring the MSG instruction in the ladder.

Message Files

To add more Message files, follow these instructions:

1. While offline, select the data files folder in the RSLogix Micro project pane followed by a right mouse
click.

Select New...

Add a new file of the type Message.
Give the file a name such as “Message1!
If desired, enter a description.

Elements should be set to 1, the default.
Select Global, the default.

Press OK.

@ NS WUk WwWN

Extended Routing Information Files

To add additional Extended Routing Information files, follow these instructions:

1. While offline, select the data files folder in the RSLogix Micro project pane followed by a right mouse
click.

Select New...

Add a new file of the type Extended Routing Information.
Give the file a name such as “RIX1”

If desired, enter a description.

Elements should be set to 1, the default.

Select Global, the default.

Press OK.

© Nk WwWN

Now you can add the MSG instruction to the ladder. See below for descriptions of the values when
configuring the MSG instruction.

I04AB User's Guide 107



108

General Tab

This Controller
Field Description
Channel: 1 (Integral)

Communication Command: CIP Generic
Data Table Address: Insert the address to read or write data

Number of Elements

Target Device

Field Description

Message Timeout: This is automatically set.

Extended Routing Info File: Routing Register File (create a unique file for each MSG)

Service: Either “Read Assembly” or “Write Assembly”

Class: 4 (hex)

Instance: Use the E/IP Configurator’s Assembly Instance number (from 100 to 115)
Attribute: 3 (hex)

7 MSG - MG9:0 : (1 Elements)

uIliHopI Send Datal Receive Datal

This Controller Control Bits

Channel [[inteqral) | Ignore if timed out (TO}: [0 ]

Communication Command: [CIP Generic Break Connection (BK}:[0]

Data Table Address (Receive): [N7.0__ | Awaiting Execution (Ew): [0 ]
Size in Bytes (Receive): E (Send):

Eror (ER): m

Target Device Message done [DN): @

Message Timeout: C] Message Transmitting (ST): @

Message Enabled (EN): @

Local / Remote : MultiHop:
Extended Routing Infa File(RIX): Error
Service: [Read Assembly | Service Code (hex) ] Ertor Code(Hex): 0
Class [hex): E] (dec): EI
Instance (hex): (dec):
Attribute (hex): (dec):

Eror Description

No erors
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MultiHop
Add Hop
Field Description
From Device: This MicroLogix
From Port: Channel 1
To Address Device:  EtherNet/IP Device (str:)
To Address: (insert IP address of PAC device)
72 MSG - MG9:0 ; (1 Elements) H(=1[E3
General  MultiHop lSend Data | Receive Dalal
Ins = Add Hop Del = Remove Hop
From Device ] From Port | To Address Type To Address
This MicroLogix Channel 1 10.192.54.46
< >

The MSG has a limit of 124 16-bit words. However, when working with the EtherNet/IP Configurator, there is a
lower limit for each assembly. For the MicroLogix family, an assembly instance may not exceed 62 DINTs
(32-bit integers).

For additional information, see “Using Counts with EtherNet/IP”on page 97.

NOTE. MicroLogix 1100 must use firmware FRN 4 (OS Series B) or newer to enable CIP Generic messaging through the
Ethernet port. MicroLogix 1400 already has CIP Generic Messaging support.
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E: Detecting I/0 Communication
Failures

One important function ladder logic should perform is to detect when an I/O communication failure occurs.
This function is crucial so the control system may properly react and notify when such a failure occurs.

When using implicit messaging, the PLC automatically restores the communications with the I/0 units. This
automatic nature allows the ladder to function on stale values even when the communication fails.

The only physical indicator of this failure on the PLC is the blinking I/O Status indicator on the front panel. If the
panel is out of reach or is not convenient to be inspected, a failure will go unnoticed.

Detecting the 1/0 Status Indicator State

ControlLogix and CompactlLogix provide a way to gain access to the value that controls the I/O Status
indicator on the front panel of the Logix controller. The command is the GSV or Get System Value instruction.

The following GSV instruction options allow the retrieval of the I/0 Status indicator. This front panel PLC
indicator offers a global status of all module connections.

When implementing the GSV instruction, use these attributes:

Attribute Description

Class Name: “Module”
Instance Name: leave blank
Attribute Name: “LedStatus”

Destination: An INT variable to receive the status

Here is an RSLogix screen capture of a configured GSV instruction to read the module’s LedStatus.

GSV
Get System Value
Class Name Module
Instance Name
Attribute Name LedStatus
Dest 10_Led_Status
01»
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The return values are (excerpted from Allen-Bradley document 1756-RM003):

Value Description

0 LED Off: No MODULE objects are configured for the controller (there are
no modules in the 1/0 Configuration section of the controller organizer).

1 Flashing red: None of the MODULE objects are Running.
2 Flashing green: At least one MODULE object is not Running.

w

Solid green: All the Module objects are Running.

Detecting Each Generic Ethernet Module's State

Many system integrators will want to know precisely which 1/0 module failed. RSLogix provides the ability to
check on the status of each Generic Ethernet Module. This is another extension of the GSV command.

To inspect the current status of the Generic Ethernet Module, additional ladder instructions need to be added
for each module in the PLC configuration.

These are the arguments for the GSV module:

Argument Description

Class Name: “Module”
Instance Name: The Generic Ethernet Module you want to test.
Attribute Name: EntryStatus

Destination: An INT variable to receive the bitmask.

Here is a screenshot of the GSV instruction configured within the Ladder. The Instance Name “PACLC"is a
Generic Ethernet Module already defined within the ladder.

GSV
Get System Value
Class Name Module
Instance Name PACLC
Attribute Name EntryStatus
Dest Module_Status
Qe

The GSV instruction may add a burden to the ladder’s scan time. As a result, the detection of I/O failures should
be implemented efficiently. Consider using a timer as a time period check to evaluate the status of the PLC's
I/0 indicator. If this indicator should indicate a failure, then a routine should be called to test the status of the
/0 units. Calling a routine after knowing there is a failure will reduce the number of GSV and conditional tests
the ladder will have to perform.

For more information on the expected values reported by this instruction, see Allen-Bradley form 1756-rm003.
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F: Generic Ethernet Module
Options

When creating a GENERIC-ETHERNET module, you may select the Comm Format. This field controls the
assumed type and the amount of data that may be transacted on this module. The communications format
selection is dependent on the data type and the amount of data that your E/IP configuration will read or write.

New Module ['S__<|
Type: ETHERMET-MODULE Generic Ethemet Module
Yendar: Allen-Bradley
Parent; EMBTA
Mame: Connection Farameters
Azzembly )
Description: Instance: Size!
Input; 125 J;I [32-bit]
Dutput: 124 - (32l
Comrmn Format: |Data -DINT ﬂ : . = s
Configuratiot: o = [E-bit)
ddress  H{IEERTT . ~ —
ata - -wdith Status =
& |PAddie{paes - INT
Data - INT -"wfith Status bt
" Host Name: |
[¥ Open Module Properties oK | Cancel | Help |

Once this dialog is completed, the Comm Format cannot be changed, so make this data selection decision
carefully.

DATA SELECTION FOR THE COMMUNICATION FORMAT

For I04AB, the communication format data type will usually be REAL (4-Bytes), DINT (32-bit integers), or INT
(16-bit integers). The selected data type always applies to both the input and output assembly. Should a
communication format be chosen with the status input assembly, this data is always considered a DINT
format.

The four primary communication format types are as follows:
Input Data. A single assembly instance of inputs from the SNAP PAC I/0.

Input Data with Status. Two assembly instances. The primary Input instance’s data may be selected. The
status assembly instance is assumed to be DINT.
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DETERMINING THE NUMBER OF ASSEMBLY INSTANCES

Data. This is the most typical selection. There is an input assembly and an output assembly. The user may
select the data type for the input and output assembly.

Data with Status. Maximum data transfer possible. There is an input, output, and a status assembly. The
user may select the native data type for the input and output assemblies. The status assembly is assumed to
be a DINT.

The following table describes the communication format data types available for the Opto 22 1/0 for A-B
implementation.

Comm Format Typical Use

The assembly instances are only comprised of REAL values or
REAL ) . . .
scaled engineering units of analog inputs or outputs.
DINT The assembly instances contain any BOOL type data (for digital
inputs or outputs).
INT The assembly instances are filled with analog inputs as type “value”
(32-bit integer in the E/IP configurator) and Boolean values.

Use the data type in the communication format that is closest to the data contained in your assembly
instances.

DETERMINING THE NUMBER OF ASSEMBLY INSTANCES

An RSLogix ETHERNET-MODULE, Generic Ethernet Module may have at least one and up to three assemblies
of data. The three assembly types are Input, Output, and Status Input. An Input assembly is required for all
configurations. Most Module configurations will have two assemblies, Input and Output. If additional Input
data is required than Input assembly’s 125 32-bit DINT limit, you may use the Status Input for additional data.
The status input will permit up to 124 32-bit words in DINT format only.

Assembly Max (Quantity of DINTS) Description
Input 125 Input data from the remote I/O unit.
Output 124 Output data to the remote 1/O unit.

Typically two less than the size | Status input data from the remote 1/0

Status of the Output Assembly Size. unit. Data is always in DINT format.

OPTO 22'S MIXED ARCHITECTURE AND THE A-B COMM FORMAT

Opto 22's architecture is based around a mixed analog and digital architecture so that assembly instances
usually have a combination of digital and analog data.

Since the Comm format will force the entire assembly to be represented as a single data type, this means that
some of the values are not adequately represented. For example, a REAL will be contained in a DINT (bitwise)
and vice versa.

RSLogix contains some methods to convert the data types.

USING CPS WITH SIMPLE DATA TYPES

14

For cases where the there is a minority data type in an assembly the ladder command, the CPS command may
be used to translate a REAL contained in a DINT to a REAL. The same applies if a DINT was contained in a REAL.
It may be converted to a DINT by using the CPS command.
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APPENDIX F: GENERIC ETHERNET MODULE OPTIONS

In this case, the CPS command is a 4-byte transfer. The instruction does not convert the data, rather it moves
the binary value of the variable to the destination.

USING CPS WITH AUDT

If there are many mixed data types in the assembly instance, CPS may be used to copy the entire module data
array to (or from) a user-defined data type (UDT). The UDT's definition must perfectly align to the assembly’s
data types.
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G: Accessing Serial Data

While it is possible to use I04AB with a serial module, it has to be done with explicit messaging, which is not
nearly as straightforward as the normal data types that can be handled using implicit messaging.

A better approach is to use a SNAP PAC controller to handle the communication with the SNAP PAC serial
module and make the data accessible via the SNAP PAC controller's Scratch Pad. The Allen-Bradley controller
can then access the data in the Scratch Pad using the normal implicit messaging method.

To use this approach you will need to develop a small PAC Control strategy to communicate directly with a
SNAP serial module on one of the controller and I/0 unit combinations:

o ASNAP PAC S-series controller with a SNAP PAC EB-series I/0 unit
o ASNAP PAC R-series combination controller and I/0 unit

Follow these steps:

1. Write a small PAC Control logic strategy to communicate directly with the SNAP serial module. Your
strategy should do the following:

- Read the values from the PLC via the Scratch Pad registers and create a string message to transmit.

—  Process the serial message transmission and parse the received data using a TCP/IP communication
handle.

—  Publish the data to the Scratch Pad.

- Indicate communication status using a simple 32-bit integer status value. Publish the
communication status value to the Scratch Pad registers, which can be read by the PLC.

2. Inthe EtherNet/IP Configurator, add the Scratch Pad registers to an EtherNet/IP assembly instance so that
the PLC can read the data from the Scratch Pad. You can use either implicit or explicit messaging to
retrieve these values. For implicit message, use Generic Ethernet Module. For explicit messaging, use a
MESSAGE object and MSG instructions.

3. Tosend data from the PLC to the SNAP-PAC controller, create another assembly instance on the controller
to allow the PLC to write data (numeric or string) to the SNAP-PAC controller's Scratch Pad registers.
Again, you can use either explicit or implicit messaging."

For an example of how to exchange data between the PLC and a PAC Controller, see “6: Connecting PAC
Control and Allen-Bradley Systems”on page 49.
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